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Safety Information
Warning
This symbol indicates that high voltage
is present inside. It is dangerous to make
any kind of contact with any internal
part of this product.

CAUTION
RISK OF ELECTRIC SHOCK DO NOT OPEN
CAUTION : TO REDUCE THE RISK OF ELECTRIC SHOCK,
DO NOT REMOVE THE COVER (OR BACK). THERE ARE NO
USER SERVICEABLE PARTS INSIDE. REFER ALL SERVICING TO
QUALIFIED PERSONNEL.

• The slots and openings in the cabinet and
in the back or bottom are provided for
necessary ventilation. To ensure reliable
operation of this apparatus, and to protect it
from overheating, these slots and openings
must never be blocked or covered.
-- Do not place this apparatus in a confined
space, such as a bookcase, or built-in
cabinet, unless proper ventilation is provided.
-- Do not place this apparatus near or over
a radiator or heat register, or where it is
exposed to direct sunlight.
-- Do not place vessels (vases etc.) containing
water on this apparatus. A water spill can
cause a fire or electric shock.
• Do not expose this apparatus to rain or place
it near water (near a bathtub, washbowl,
kitchen sink, or pool, etc.). If this apparatus
accidentally gets wet, unplug it and contact
an authorized dealer immediately.
• This apparatus uses batteries. In your
community, there might be environmental
regulations that require you to dispose of
these batteries properly. Please contact your
local authorities for disposal or recycling
information.
• Do not overload wall outlets, extension cords
or adaptors beyond their capacity, since this
can result in fire or electric shock.
• Route power-supply cords so that they
are not likely to be walked on or pinched
by items placed on or against them. Pay
particular attention to cords at the plug end,
at wall outlets, and the point where they exit
from the apparatus.
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This symbol indicates that important
literature concerning operation and
maintenance has been included with
this product.

• To protect this apparatus from a lightning
storm, or when it is left unattended and
unused for long periods of time, unplug
it from the wall outlet and disconnect the
antenna or cable system. This will prevent
damage to the set due to lightning and
power line surges.
• Before connecting the AC power cord to the
DC adaptor outlet, make sure the voltage
designation of the DC adaptor corresponds
to the local electrical supply.
• Never insert anything metallic into the open
parts of this apparatus. Doing so may create
a danger of electric shock.
• To avoid electric shock, never touch the
inside of this apparatus. Only a qualified
technician should open this apparatus.
• Make sure to plug the power cord in until
it is firmly seated. When unplugging the
power cord from a wall outlet, always pull
on the power cord's plug. Never unplug by
pulling on the power cord. Do not touch the
power cord with wet hands.
• If this apparatus does not operate normally
- in particular, if there are any unusual
sounds or smells coming from it - unplug
it immediately and contact an authorized
dealer or service center.

English
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• To clean this apparatus, unplug the power
cord from the wall outlet and wipe the
product using a soft, dry cloth. Do not
use any chemicals such as wax, benzene,
alcohol, thinners, insecticide, air fresheners,
lubricants, or detergent. These chemicals can
damage the appearance of the product or
erase the printing on the product.
• Do not expose this apparatus to dripping
or splashing. Do not put objects filled with
liquids, such as vases on the apparatus.
• Do not dispose of batteries in a fire.
• Do not plug multiple electric devices into the
same wall socket. Overloading a socket can
cause it to overheat, resulting in a fire.
• There is danger of an explosion if you
replace the batteries used in the remote with
the wrong type of battery. Replace only with
the same or equivalent type.
• WARNING - TO PREVENT THE
SPREAD OF FIRE, KEEP CANDLES
AND OTHER ITEMS WITH OPEN
FLAMES AWAY FROM THIS
PRODUCT AT ALL TIMES.
• WARNING - This product contains chemicals
known to the State of California to cause
cancer and reproductive toxicity.

FCC NOTE (for U.S.A)
This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC rules.
These limits are designed to provide reasonable
protection against harmful interference in
a residential installation. This equipment
generates, uses and can radiate radio
frequency energy and, if not installed and used
in accordance with the instructions, may cause
harmful interference to radio or television
reception, which can be determined by turning
the equipment off and on.
The user is encouraged to try to correct the
interference by one or more of the following
measures.
• Reorient or relocate the receiving antenna.
• Increase the separation between the
equipment and receiver.
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• Maintenance of Cabinet.
-- Before connecting other components to
this product, be sure to turn them off.
-- If you move your product suddenly from a
cold place to a warm place, condensation
may occur on the operating parts and lens
and cause abnormal disc playback. If this
occurs, unplug the product, wait for two
hours, and then connect the plug to the
power outlet. Then, insert the disc, and try
to play back again.
• Be sure to pull the power plug out of the
outlet if the product is to remain unused or
if you are leaving the house for an extended
period of time (especially when children,
elderly, or disabled people will be left alone
in the house).
-- Accumulated dust can cause an electric
shock, an electric leakage, or a fire by
causing the power cord to generate sparks
and heat or the insulation to deteriorate.
• Contact an authorized service center for
information if you intend to install your
product in a location with heavy dust,
high or low temperatures, high humidity,
chemical substances, or where it will operate
24 hours a day such as in an airport, a train
station, etc. Failing to do so may lead to
serious damage of your product.
• Use only a properly grounded plug and wall
outlet.
-- An improper ground may cause electric
shock or equipment damage. (Class l
Equipment only.)
• To turn this apparatus off completely, you
must disconnect it from the wall outlet.
Consequently, the wall outlet and power
plug must be readily accessible at all times.
• Do not allow children to hang on the
product.
• Store the accessories (battery, etc.) in a
location safely out of the reach of children.
• Do not install the product in an unstable
location such as a shaky self, a slanted floor,
or a location exposed to vibration.
• Do not drop or strike the product. If the
product is damaged, disconnect the power
cord and contact a service center.

Safety Information
• Connect this equipment into an outlet on
a circuit different from that to which the
receiver is connected.
• Consult the dealer or an experienced radio/
TV technician for help.
• This class B digital product meets all
requirements of the Canadian Interference Causing Equipment Regulations.

Note to CATV system installer
This reminder is provided to call CATV system
installer's attention to Article 820-40 of
the National Electrical Code (Section 54 of
Canadian Electrical Code, Part I) that provides
guidelines for proper grounding and, in
particular, specifies that the cable ground shall
be connected to the grounding system of the
building as close to the point of cable entry as
practical.

CLASS 1 LASER product
This Compact Disc player is classified as a
CLASS 1 LASER product. Use of controls,
adjustments or performance of procedures
other than those specified herein may result in
hazardous radiation exposure.
Complies with 21CFR 1040.10 except for
deviations pursuant to Laser Notice No. 50,
dated June 24, 2007.
DANGER :
• VISIBLE AND INVISIBLE LASER RADIATION
WHEN OPEN. AVOID DIRECT EXPOSURE TO
BEAM. (FDA 21 CFR)
CAUTION :
• CLASS 3B VISIBLE AND INVISIBLE LASER
RADIATION WHEN OPEN. AVOID EXPOSURE
TO THE BEAM. (IEC 60825-1)
• THIS product UTILIZES A LASER. USE
OF CONTROLS OR ADJUSTMENTS OR
PERFORMANCE OF PROCEDURES OTHER
THAN THOSE SPECIFIED HEREIN MAY
RESULT IN HAZARDOUS RADIATION
EXPOSURE. DO NOT OPEN THE COVER.
DO NOT REPAIR THE PRODUCT YOURSELF.
REFER SERVICING TO QUALIFIED
PERSONNEL.
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CLASS 1
LASER PRODUCT
KLASSE 1
LASER PRODUKT
LUOKAN 1
LASER LAITE
KLASS 1
LASER APPARAT
PRODUCTO	LÁ SER CLASE 1

||NOTE |
\\ If the Region number of a Blu-ray Disc/DVDs does
not correspond to the Region number of this
product, the product cannot play the disc.

Precautions
Important Safety Instructions
Read these operating instructions carefully
before using the unit. Follow all the safety
instructions listed below.
Keep these operating instructions handy for
future reference.
1.

Read these instructions.

2.

Keep these instructions.

3.

Heed all warnings.

4.

Follow all instructions.

5.

Do not use this apparatus near water.

6.

Clean only with a dry cloth.

7.

Do not block any ventilation openings.
Install in accordance with the
manufacturer's instructions.

8.

Do not install near any heat sources such
as radiators, heat registers, stoves, or
other apparatus (including AV receivers)
that produce heat.

9.

Do not defeat the safety purpose of the
polarized or grounding-type plug. A
polarized plug has two blades with one
wider than the other. A grounding type
plug has two blades and a third grounding
prong. The wide blade or the third
prong are provided for your safety. If the
provided plug does not fit into your outlet,
consult an electrician for replacement of
the obsolete outlet.
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11. Only use attachments/accessories
specified by the manufacturer.
12. Use only with the cart,
stand, tripod, bracket,
or table specified by the
manufacturer, or sold with
the apparatus. When a cart
is used, use caution when
moving the cart/apparatus combination to
avoid injury from tip-over.
13. Unplug this apparatus during lightning
storms or when unused for long periods
of time.
14. Refer all servicing to qualified service
personnel. Servicing is required when the
apparatus has been damaged in any way,
such as when the power-supply cord or
plug is damaged, liquid has been spilled
or objects have fallen into the apparatus,
the apparatus has been exposed to rain or
moisture, does not operate normally, or
has been dropped.

Using the 3D function
IMPORTANT HEALTH AND SAFETY
INFORMATION FOR 3D PICTURES.
Read and understand the following safety
information before using the 3D function.
• Some viewers may experience discomfort
while viewing 3D TV such as dizziness,
nausea, and headaches.
If you experience any such symptom, stop
viewing 3D TV, remove the 3D Active
Glasses, and rest.
• Watching 3D images for an extended period
of time may cause eye strain. If you feel eye
strain, stop viewing 3D TV, remove your 3D
Active Glasses, and rest.
• A responsible adult should frequently check
on children who are using the 3D function.
If there are any reports of tired eyes,
headaches, dizziness, or nausea, have the
child stop viewing 3D TV and rest.
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• Do not use the 3D Active Glasses for other
purposes (such as general eyeglasses,
sunglasses, protective goggles, etc.).
• Do not use the 3D function or 3D Active
Glasses while walking or moving around.
Using the 3D function or 3D Active Glasses
while moving around may cause you to
bump into objects, trip, and/or fall, and
cause serious injury.
• If you want to enjoy 3D content, connect a
3D device (3D compliant AV receiver or TV)
to the player's HDMI OUT port using a highspeed HDMI cable. Put on 3D glasses before
playing the 3D content.
• The player outputs 3D signals only through
HDMI cable connected to the HDMI OUT
port.
• The video resolution in 3D play mode is
determined by the resolution of the original
3D video. You can not change the resolution.
• Some functions such as BD Wise, screen size
adjustment, and resolution adjustment may
not operate properly in 3D play mode.
• You must use a high-speed HDMI cable for
proper output of the 3D signal.
• Stay at least three times the width of the
screen from the TV when watching 3D
images. For example, if you have a 46-inch
screen, stay 138 inches (11.5 feet) from the
screen.
• Place the 3D video screen at eye level for the
best 3D picture.
• When the player is connected to some 3D
devices, the 3D effect may not function
properly.
• This player does not convert 2D content into
3D.
• "Blu-ray 3D" and "Blu-ray 3D" logo are
trademarks of the Blu-ray Disc Association.
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10. Protect the power cord from being walked
on or pinched particularly at plugs,
convenience receptacles, and the point
where it exits the apparatus.
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Getting Started
Accessories
Check for the supplied accessories shown below.

Batteries for Remote Control (AAA Size)
(4301-000115)

User Manual
(AK68-02465A)
SOURCE

VOL

VOL

– + VOL
+–
VOL

1

2

4

5

7

8

DISC MENU

TV

SMART

6
9

POPUP

HOME

HOME

REPEAT

HUB

APPS

TOOLS

INFO

RETURN

EXIT

A

SEARCH

PANDORA

Quick Setup Guide
(AK68-02464A)

3

TITLE MENU

0

B

C

D

DIGITAL

SUBTITLE

INPUT

AUDIO SUBTITLE LIGHT

Remote Control
(AK59-00177B)
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Front Panel

STOP BUTTON

OPEN/CLOSE BUTTON
POWER BUTTON

USB HOST

DISPLAY
DISC TRAY

REMOTE CONTROL SENSOR

||NOTE |
\\ To upgrade the product's software through the USB Host jack, you must use a USB memory stick.
\\ When the product displays the Blu-ray Disc's menu, you cannot start the movie by pressing the Play button on
the product or the remote control. To play the movie, you must select Play Movie or Start in the disc's menu, and
then press the v button on the remote control.

Rear Panel

HDMI OUT

LAN
DIGITAL AUDIO OUT
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PLAY/PAUSE BUTTON

Getting Started
Remote Control
Tour of the Remote Control
After setup, allows you to set the input
source on your TV.
Turn the product on and off.

VOL

Use to enter the disc menu.

VOL

– + VOL
+–
VOL

Press to open and close the disc tray.

Press the number buttons to operate
options.

Turn the TV on and off.

SOURCE

1

2

4

5

7

8

DISC MENU

TV

3
6
9

TITLE MENU

0

POPUP

Press to skip backwards or forwards.

Press to move to the Home screen.

Use to enter the Popup menu/Title menu.
Press to search backwards or forwards.
Press to pause a disc.

Press to stop a disc.
Press to use Apps.

TV volume adjustment.

SMART

HOME

HOME

REPEAT

HUB

APPS

TOOLS

INFO

Press to play a disc.
Allows you to repeat a title, chapter,
track or disc.
Use to display the playback information.

Press to use the Tools menu.
Use to select menu items and change
menu values.
Return to the previous menu.
These buttons are used both for menus
on the product and also several Blu-ray
Disc functions.
Press to search contents.

RETURN

A

SEARCH

PANDORA

EXIT

B

C

D

DIGITAL

SUBTITLE

INPUT

AUDIO SUBTITLE LIGHT

Use to access various audio functions on
a disc.

Press to exit the menu.
Press to backlight the buttons on the
remote control. This function is convenient
when you are using the player at night or
in a dark room. (If you turn the backlight
on, battery usage time will be reduced.)
Press to switch the Blu-ray Disc/DVD's
subtitle language.

||NOTE |
\\ If the remote control does not operate properly:
-- Check the polarity +/– of the batteries.
-- Check if the batteries are drained.
-- Check if the remote sensor is blocked by
obstacles.
-- Check if there is any fluorescent lighting nearby.

Installing batteries

||CAUTION |
\\ Dispose of batteries according to local environmental
regulations. Do not put them in the household trash.
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Setting the Remote Control to Operate
Your TV

Button

Function

TV POWER

Used to switch the television on and
off.

TV SOURCE

Used to select an external source
connected to the TV.

Brand

Code

Brand

SAMSUNG

TV POWER+01, +02,
+03, +04, +05, +06,
+07, +08, +09

NOBLEX

TV POWER+66

NOKIA

TV POWER+74

AIWA

TV POWER+82

ANAM

TV POWER+10, +11,
+12, +13, +14, +15,
+16, +17, +18

BANG &
OLUFSEN

TV POWER+57

TV VOL (+/–) Used to adjust the volume of the
television.

BLAUPUNKT

TV POWER+71

BRANDT

TV POWER+73

TV CH (,/.) Used to select the desired channel.

BRIONVEGA

TV POWER+57

CGE

TV POWER+52

||NOTE |
\\ The functions listed above will not necessarily work
on all televisions. If you encounter problems, use the
TV remote control.

To determine whether your television is
compatible, follow the instructions below.

CONTINENTAL
TV POWER+75
EDISON

Code

NORDMENDE

TV POWER+72, +73,
+75

PANASONIC

TV POWER+13, +53,
+54, +74, +75

PHILIPS

TV POWER+06, +55,
+56, +57

PHONOLA

TV POWER+06, +56,
+57

PIONEER

TV POWER+58, +59,
+73, +74

RADIOLA

TV POWER+06, +56

RADIOMARELLI TV POWER+57
RCA

TV POWER+45, +46

REX

TV POWER+74

SABA

TV POWER+57, +72,
+73, +74, +75

DAEWOO

TV POWER+19, +20,
+23, +24, +25, +26,
+27, +28, +29, +30,
+31, +32, +33, +34

EMERSON

TV POWER+64

FERGUSON

TV POWER+73

SALORA

TV POWER+74

TV POWER+06, +49,
+57

SANYO

TV POWER+41, +42,
+43, +44, +48

1.

Switch your television on.

2.

Point the remote control towards the
television.

FORMENTI

TV POWER+57

SCHNEIDER

TV POWER+06

FUJITSU

TV POWER+84

SELECO

TV POWER+74

Press and hold the TV POWER button.
Then, using the number buttons, enter
the two-figure code in the table to the
right that corresponds to the brand of
your television.
If your television is compatible with the
remote control, it will switch off.
The remote is now programmed to
operate the TV.

GRADIENTE

TV POWER+70

SHARP

TV POWER+36, +37,
+38, +39, +48

3.

FINLUX

||NOTE |
\\ If several codes are listed for your television brand,
try each one in turn until you find one that works.
\\ If you replace the remote control’s batteries, you
must set the brand code again.
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GRUNDIG

TV POWER+49, +52,
+71

HITACHI

TV POWER+60, +72,
+73, +75

IMPERIAL

TV POWER+52

SIEMENS

TV POWER+71

SINGER

TV POWER+57

SINUDYNE

TV POWER+57

JVC

TV POWER+61, +79

SONY

LG

TV POWER+06, +19,
+20, +21, +22, +78

TELEAVA

LOEWE

TV POWER+06, +69

LOEWE OPTA TV POWER+06, +57
MAGNAVOX

TV POWER+40

METZ

TV POWER+57

MITSUBISHI

TV POWER+06, +48,
+62, +65

MIVAR

TV POWER+52, +77

TV POWER+35, +48
TV POWER+73

TELEFUNKEN

TV POWER+67, +73,
+75, +76

THOMSON

TV POWER+72, +73,
+75

THOMSON ASIA TV POWER+80, +81
TOSHIBA
WEGA

TV POWER+47, +48,
+49, +50, +51, +52
TV POWER+57

NEC

TV POWER+83

YOKO

TV POWER+06

NEWSAN

TV POWER+68

ZENITH

TV POWER+63

English

02 Getting Started

You can control certain functions of your TV
with this remote control.

TV Control Codes

Connections
Connecting to a TV
Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the
HDMI IN jack on your TV.
-- Do not connect the power cord to the wall outlet until you have made all the other connections.
-- When you change the connections, turn off all devices before you start.

Audio
Video

||NOTE |
\\ If you use an HDMI-to-DVI cable to connect to your display device, you must also connect the DIGITAL AUDIO
OUT on the product to an audio system to hear audio.
\\ An HDMI cable outputs digital video and audio, so you don't need to connect an audio cable.
\\ Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user manual of your TV.
\\ When you connect the product to your TV using the HDMI cable or to a new TV, and then turn it on for the first
time, the product automatically sets the HDMI output resolution to the highest supported by the TV.
\\ A long HDMI cable may cause screen noise. If this occurs, set HDMI Deep Color to Off in the menu.
\\ To view video in the HDMI 720p,1080i,1080p or 2160p output mode, you must use a High speed (category 2)
HDMI cable.
\\ HDMI outputs only a pure digital signal to the TV.
If your TV does not support HDCP (High-bandwidth Digital Content Protection), random noise appears on the
screen.
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Connecting to an Audio System

Method 1 Connecting to an HDMI supported AV receiver
• Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to
the HDMI IN jack on your receiver.
• Best quality (Recommended)

Method 2 Connecting to an AV receiver with Dolby Digital or DTS decoder
• Using a digital Optical cable (not supplied), connect the OPTICAL DIGITAL AUDIO OUT jack on
the product to the DIGITAL OPTICAL IN jack of the receiver.
• Good quality
• You will hear sound only through the front two speakers with Digital Output set to PCM.

Method 1

Method 2

Audio

Audio
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You can connect this product to the audio system using the methods illustrated below.
-- Do not connect the power cord to the wall outlet until you have made all the other connections.
-- When you change the connections, turn off all devices before you start.

Connections
Wireless Network

Connecting to a Network Router
You can connect your product to your network
router using one of the methods illustrated
below.
To use the AllShare network functionality,
you must connect your PC to your network as
shown in the illustrations.
The connection can be wired or wireless.

Wireless Router

Wired Network

Broadband
service
Broadband modem
(with integrated router)
Broadband
service

Or

||NOTE |
\\ If your wireless router supports DHCP, this product
can use a DHCP or static IP address to connect to
the wireless network.
\\ Set your wireless router to Infrastructure mode. Adhoc mode is not supported.
\\ The product supports only the following wireless
security key protocols:
-- WEP (OPEN/SHARED), WPA-PSK (TKIP/AES),
WPA2-PSK (TKIP/AES)

Router

Broadband
service
Broadband
modem

||NOTE |
\\ Your router or your Internet Service Provider's
policies may prevent the product from accessing
Samsung's software update server. If this occurs,
contact your Internet Service Provider (ISP) for more
information.

\\ Select a channel on the wireless router that is not
currently being used. If the channel set for the
wireless router is currently being used by another
device nearby, it will result in interference and
communication failure.
\\ If you select the Pure High-throughput (Greenfield)
802.11n mode and set the Encryption type on your
router to WEP, TKIP or TKIP-AES (WPS2Mixed), the
product will not support a connection in compliance
with new Wi-Fi certification specifications.
\\ Wireless LAN, by its nature, may cause interference,
depending on the operating conditions (router
performance, distance, obstacles, interference by
other radio devices, etc).

\\ DSL users, please use a router to make a network
connection.
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Settings
The Initial Settings Procedure

The Home Screen
4 5
1

2

PLAY DISC

3

MOVIES & TV SHOWS

MULTIMEDIA

6
APPS

No Disc

After you have connected the product to
your TV, turn on the TV and product. When
you turn on the product the first time, the
product's Initial Settings screen appears on
the TV. The Initial Settings procedure lets you
set the On Screen Display (OSD) and menu
languages, the aspect ratio (screen size), and
network configuration, and connect the player
to the Internet. For complete Initial Settings
instructions, see the Quick Setup Guide.
||NOTE |
\\ If you skip Network Setup during the Initial Settings
procedure, you can configure your network settings
later. See "Configuring Your Network Connection"
on pages 21~24 for instructions.
\\ If you want to display the Initial Settings screen
again and make changes, select Settings > System >
Setup in the Home screen or select the Reset option.
(See pages 19 or 21)
\\ If you want to use an Anynet+(HDMI-CEC) function,
please follow the instructions below.
1) Connect the product to an Anynet+(HDMI-CEC)compliant Samsung TV using HDMI Cable.
2) Set the Anynet+(HDMI-CEC) feature to On in
both the TV and the product.
3) Set the TV to the Initial Settings Procedure.
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WebBrowser

1

2

3

4

5

6

8

9

Screen Mirroring

Settings

PLAY DISC : Lets you play photos, videos, or
music content from Disc.
MOVIES & TV SHOWS : Lets you view Movies
and TV Shows from the Internet.

2

||NOTE |
\\ Depending on your country, this menu
function may not be supported.

3

MULTIMEDIA : Lets you play photos, videos, or
music content from USB or mobile devices, or PCs.

4

Sign In : Lets you log in with your Samsung account.

5

Search : Lets you search for contents in Movies
and TV Shows, Apps and YouTube by entering
corresponding search words.

6

APPS : Gives you access to various applications
you can download.

7

My Apps : Apps downloaded from My Apps
are displayed.

8

Screen Mirroring : Lets you view the screen of
your smart phone or android tablet on a TV
you have connected to this product.

9

Settings : Opens the product's menu. In the
menu can set various functions to suit your
personal preferences.

||NOTE |
\\ If you leave the product in the stop mode for more than
5 minutes without using it, a screen saver will
appear on your TV. If the product is left in the screen
saver mode for more than 20 minutes, the power
will automatically turn off.
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• The Home screen will not appear if you do not
configure the initial settings.
• The OSD (On Screen Display) may change in this
product after you upgrade the software version.
• The access steps may differ depending on the
menu you selected.

Settings
Detailed Function Information

Accessing the Settings Screen
Select Settings on the Home screen, and
then press v button. The Settings screen
appears.

1.

Settings
Picture
Picture
Sound
Network

UHD Output

Auto

3D Settings
TV Aspect Ratio

16:9 Original

Smart Hub

BD Wise

System

Resolution

Auto

Movie Frame (24Fs)

Auto

Support

Each Settings function, menu item, and
individual option is explained in detail onscreen. To view an explanation, use the
▲▼◀▶ buttons to select the function, menu
item, or option. The explanation will usually
appear on the right side of the screen.
A short description of each Settings function
starts on the next page. Additional information
on some of the functions is also in the
Appendix of this manual.

Off

SOURCE

DVD 24Fs Conversion
VOL

Off

VOL

– + VOL
+–
VOL
SAMSUNG TV

1 2 3
To access the menus, sub-menus, and

2.

options on the
please refer
4 Settings
5 screen,
6
to the remote control illustration below.

7

8

DISC MENU

9

TITLE MENU

Buttons on the RemotePOPUP
0 Control Used
for the Settings Menu

1
SMART

HOME

HOME

REPEAT

HUB

APPS

TOOLS

INFO

3
2

RETURN

A

SEARCH

EXIT

B

C

AUDIO SUBTITLE

4

D

FULL

1

SCREEN
PANDORA :DIGITAL
INPUT to the Home
HOME button
PressSUBTITLE
to move
screen.

2

RETURN button : Press to return to the previous
menu.

3

v (Enter) / DIRECTION buttons :
• Press ▲▼◀▶ to move the cursor or select
an item.
• Press the v button to activate the currently
selected item or confirm a setting.

4

EXIT button : Press to exit the current menu.
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Picture
UHD Output
This option outputs HDMI video at UHD
(Ultra High Definition) resolution. This is only
available when Movie Frame is set to Auto.
||NOTE |
\\ To use this feature, you must connect the product
to a device that supports UHD resolution and you
must have content that plays at 24Fs (film speed).
\\ This device cannot play UHD contents However
contents with resolution lower than Full HD can
be up-scaled to UHD.
\\ For UHD resolution output, only 2160*3840 24
frame rate output is available.
3D Settings
Select whether to play a Blu-ray Disc with 3D
contents in 3D Mode.
If you move to the Home or Apps screen
while in 3D mode, the product will switch to
2D mode automatically.

Movie Frame (24Fs)
If the product is connected to a 24Fs
compatible TV, setting the Movie Frame
(24Fs) feature to Auto lets the product adjust
its HDMI output to 24 frames per second
automatically for improved picture quality.
• You can enjoy the Movie Frame (24Fs)
feature only on a TV supporting this frame
rate.
• Movie Frame is only available when the
product is in the HDMI 1080i or 1080p
output resolution modes.
DVD 24Fs Conversion
Converts DVD playback to 24 frames per
second and outputs it via HDMI. This option is
only available when Movie Frame (24Fs) is set
to on.
Fit Screen Size

TV Aspect Ratio

Set the screen to the optimal size. (Apply
Smart Hub, Screen Mirroring only)

Lets you adjust the output of the product to
the screen size and screen format of your TV.

HDMI Color Format

BD Wise
BD Wise is Samsung's latest inter-connectivity
feature.
When you connect a Samsung product and a
Samsung TV with BD Wise to each other via
HDMI, and BD Wise is on in both the product
and TV, the product outputs video at the
video resolution and frame rate of the Blu-ray
Disc/DVD.
Resolution
Set the output resolution of the HDMI video
signal to BD Wise, Auto, 1080p, 1080i, 720p
or 480p.
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Lets you set the color space format for the
HDMI output so that it matches the capabilities
of the connected device (TV, monitor, etc). The
screen goes black momentarily after you have
selected a format.
HDMI Deep Color
Lets you set the product to output HDMI video
with Deep Color. Deep Color provides more
accurate color reproduction with greater color
depth.
Progressive Mode
Lets you improve picture quality when viewing
DVDs.

English

04 Settings

The number indicates the number of lines of
video per frame.
The i and p indicate interlaced and progressive
scan, respectively. Generally, the more lines,
the higher quality.

Settings Menu Functions

Settings
Sound

Audio Sync

Digital Output
Lets you select the digital audio output format
that is suitable for your TV or AV Receiver. For
more details, see the digital output selection
table on page 50.
PCM Downsampling
Lets you choose to have 96Khz PCM signals
downsampled to 48Khz before they are
outputted to an amplifier. Choose On if your
amplifier or receiver is not compatible with a
96Khz signal.
Dynamic Range Control

In some cases when the product is connected
to a digital TV, the audio signal may not
synchronize with the video signal. If this
occurs, adjust the audio delay time to match
the video signal.
• You can set the audio delay time between 0
msec and 250 msec. Adjust it to the optimal
setting.
||NOTE |
\\ The audio delay time you specify may not be
exact depending on the played content.

Network

Lets you apply dynamic range control to Dolby
Digital, Dolby Digital Plus, and Dolby TrueHD
audio.
Auto : Automatically controls the dynamic
range of Dolby TrueHD audio, based on
information in the Dolby TrueHD soundtrack.
Also turns dynamic range control on for
Dolby Digital and Dolby Digital Plus.
Off : Leaves the dynamic range
uncompressed, letting you hear the original
sound.
On : Turns dynamic range control on for all
three Dolby formats. Quieter sounds are
made louder and the volume of loud sounds
is reduced.
Downmixing Mode
Lets you select the multi-channel downmix
method that is compatible with your stereo
system. You can choose to have the product
downmix to normal stereo or to surround
compatible stereo.
DTS Neo:6 Mode
You can enjoy multichannel sound via HDMI
output from a 2 channel audio source.
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Network Status
Lets you check the current network and
Internet status.
Network Settings
Configure the network connection so you
can enjoy various features such as Internet
services or AllShare functionality, and perform
Software Updates.
Wi-Fi Direct
Lets you connect a Wi-Fi Direct device to the
product using a peer-to-pear network, without
the need for a wireless router.
Note that if the product is connected to a
wireless network, it may be disconnected
when you use Wi-Fi Direct.
||NOTE |
\\ Text files, such as files with a .TXT or .DOC
extension, will not display when you are using the
Wi-Fi Direct function.
Multimedia Device Settings
Lets you control which devices on your
network, such as smart phones and tablets,
can share content with your product.

English

Caption

Lets you input a name for the product that will
identify it on your networks.

For use with VOD playback that supports
closed captions. Lets you change the displayed
caption's font color and size.

BD-Live Settings
Set various BD-Live functions. BD-Live allows
you to access extra features available on
some Blu-ray Discs if you are connected to the
Internet.
BD-Live Internet Connection : Lets you fully
allow, partly allow, or prohibit a BD-Live
Internet connection.
BD Data Management : Manage BD data
downloaded from a BD-Live service or Blu-ray
Disc.

||NOTE |
\\ The Caption function does not work with VOD
services that do not support closed captions.
Terms & Policy
You must review and agree to both the App
Terms & Conditions and the privacy policy to
use App services.
Samsung account Terms and Conditions,
Privacy Policy
You can view and agree to the terms or privacy
policy for your Samsung account and a variety
of other services.

Smart Hub
Apps Settings

Reset Smart Hub

Lets you configure App notification settings
and view basic info about your Apps.
Push Notification Settings : Receive
notifications from selected services.
Properties : See basic info about Apps.

Resets all Smart Hub settings to their default
settings. To use, you must enter the security PIN.

System

VOD Rating Lock
Lets you lock access to Video on Demand
(VOD) content based on its rating. To use, you
must enter the security PIN.
||NOTE |
\\ Depending on your country, this menu function
may not be supported.

Setup
Lets you re-run the Initial Settings procedure.
See the Quick Setup Guide for details.
Quick Start
Lets you set the product to turn on quickly by
decreasing the boot time.
||NOTE |
\\ If this function is set to On, Standby power
consumption will be increased.
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Device Name

Settings
Language

Security

You can select the language you prefer for the
On-screen menu, disc menu, audio, subtitles,
etc.
• The language you select for the disc menu,
disc audio, or subtitles will only appear if it is
supported on the disc.

The default security PIN is 0000. Enter the
default PIN to access the security function if
you haven't created your own PIN. After you
have accessed the security function for the first
time, change the PIN using the Change PIN
function.
BD Parental Rating : Prevents playback of
Blu-ray Discs with a rating equal to or above
a specific age rating you have set unless you
enter the PIN.
DVD Parental Rating : Prevents playback
of DVDs with a rating above a specific
numerical rating you have set unless you
enter the PIN.
Change PIN : Change the 4-digit PIN used to
access security functions.

Device Manager
You can connect a wireless USB keyboard or
mouse to the USB port on the front of the
product.
Keyboard Settings : Lets you configure a
wireless USB keyboard connected to the
product.
||NOTE |
\\ You can use the keyboard only when a QWERTY
keyboard screen or window appears in the Web
Browser.
Mouse Settings : Lets you configure a
wireless USB mouse connected to the
product. You can use the mouse in the
product's menu and the Web Browser in the
same way you use a mouse on your PC.

`` If you forget your PIN:
1.

Remove any disc or USB storage device.

2.

Press and hold the @ button on the top
panel for 5 seconds or more.
The initialization message appears on
the screen, and the power will turn off
automatically.
When you turn your product on again,
all the settings will be reset.

`` To use a mouse with the product's menu:
1.

Connect the USB mouse to the product.

2.

Click the primary button you selected
in Mouse Settings. The Simple Menu
appears.

3.

Click the menu options you want.

||NOTE |
\\ Some USB HID keyboards and mice may not be
compatible with your product.
\\ Some HID keyboard keys may not work.
\\ Wired USB keyboards are not supported.

General
You can change the options listed below to
match your preferences.
Front Display : Change the brightness of the
front panel.
Time Zone : Select the time zone in which
you live.
Menu Transparency : Lets you adjust the
transparency of the menu box.
Anynet+ (HDMI-CEC)

\\ Some applications may not be supported.

Anynet+ is a convenient function that offers
linked operations with other Samsung product
that have the Anynet+ feature and lets you
control those products with one Samsung TV
remote. To operate this function, you must
connect this product to an Anynet+ Samsung
TV using an HDMI cable.

\\ If a wireless HID Keyboard does not operate
because of interference, move the keyboard
closer to the product.
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Support

Networks and the Internet

When activated, lets Samsung Call Center
agents diagnose and fix problems with your
player remotely. Requires an active Internet
connection.
||NOTE |
\\ Remote Management service might not be
available in some countries.
\\ To use Remote Management:
1) Call the Samsung Contact Center and ask for
remote support.
2) Open the player's menu on your TV and go to
the Support section.
3) Select Remote Management, and then read
and agree to the service agreements. When
the PIN screen appears, provide the PIN
number to the agent.
4) The agent accesses your player.

Configuring Your Network Connection

The Software Update menu allows you to
upgrade the product's software for performance
improvements or additional services.

Before you begin, contact your ISP to find
out if your IP address is static or dynamic. If it
is dynamic, and you have a wired or wireless
network, we recommend using the Automatic
configuration procedures described below.
If you are connecting to a wired network,
connect the product to your router using a
LAN cable before you start the configuration
procedure.
If you are connecting to a wireless network,
disconnect any wired network connection
before you begin.
To begin configuring your network connection,
follow these steps:

Contact Samsung

Wired Network

Software Update

Provides contact information for assistance
with your product.

ĞĞ

Reset
Resets all settings to their default settings
except for the network and Smart Hub
settings, and then starts the Setup function.
To use, you must enter the security PIN. The
default security PIN is 0000.

Wired - Automatic

1.

In the Home screen, select Settings, and
then press the v button.

2.

Select Network, and then press the v
button.

3.

Select Network Settings, and then press
the v button.
Select Wired in the Network Settings
screen, and then press the v button.

4.
5.
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Select the Connect button, and then press
the v button. The product detects the
wired connection, verifies the network
connection and then connects to the
network.

04 Settings

When you connect this product to a network,
you can use network based applications and
functions such as Smart Hub and BD-LIVE, and
upgrade the product's software through the
network connection. For more information
about accessing and using Internet services,
see the Network Services chapter of this
manual on pages 38~46. Instructions for
configuring the network connection start
below.

Remote Management

Settings
ĞĞ

Wireless Network

Wired - Manual

If you have a static IP address or the Automatic
procedure does not work, you'll need to set
the Network Settings values manually.
Follow Steps 1 and 2 in Wired - Automatic,
and then follow these steps:
1.

Select Network Status. The product
searches for a network, and then displays
the connection failed message.

2.

On the bottom of the screen, select IP
Settings, and then press the v button.
The IP Settings screen appears.

3.

Select the IP Setting field, and then press
the v button.
Select Enter manually in the IP Setting
field, and then press the v button.

4.
5.

6.

7.

Select a value to enter (IP Address, for
example), and then press the v button.
Use the number keypad on your remote
control to enter the numbers for the value.
You can also enter numbers using the
▲▼ buttons. Use the ◀▶ buttons on the
remote control to move from entry field
to entry field within a value. When done
with one value, press the v button.
Press the ▲ or ▼ button to move to
another value, and then enter the
numbers for that value following the
instructions in Step 5.

You can set up a wireless network connection
in four ways:
-- Wireless Automatic
-- Wireless Manual
-- WPS(PBC)
-- WPS(PIN)
When you configure the wireless network
connection, any wireless network devices
currently connected through the product
or, if applicable, the product's current wired
connection, will be disconnected.
ĞĞ

Wireless - Automatic

1.

In the Home screen, select Settings, and
then press the v button.

2.

Select Network, and then press the v
button.

3.

Select Network Settings, and then press
the v button.
Select Wireless in the Network Settings
screen, and then press the v button. The
product searches for and then displays a
list of the available networks.

4.

Network Settings
Select your network type.
Network type

Repeat Steps 5 and 6 until you have filled
in all values.

Wireless network

||NOTE |
\\ You can get the Network values from your Internet
provider.
8.

When finished entering all the values,
select OK, and then press the v
button. The product verifies the network
connection and then connects to the
network.
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Wireless

You can connect your Bluray player to the internet.
Please select which wireless
network to use.

iptime23
iptime
solugen_edu#2
Refresh

5.
6.
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WPS(PBC)

Select the desired network, and then press
the v button.
On the Security screen, enter your
network's Security Code or Pass Phrase.
Enter numbers directly using the number
buttons on your remote control. Enter
letters by selecting a letter with an arrow
button, and then pressing v button.

7.

8.

When finished, select Done and then press
the v button. The product verifies the
network connection and then connects to
the network.
When verification is complete, select OK,
and then press the v button.

||NOTE |
\\ You should be able to find the Security Code or Pass
Phrase on one of the set up screens you used to set
up your router or modem.
ĞĞ

Wireless - Manual

If you have a static IP address or the Automatic
procedure does not work, you'll need to set
the Network Settings values manually.
1.

Follow the directions in Wireless Automatic through Step 5.

2.

The product searches for a network,
and then displays the connection failed
message.

||NOTE |
\\ You can get the Network values from your Internet
provider.
When finished, select OK, and then
press the v button. The Security Screen
appears.

9.

10. On the Security screen, enter your
network's Security Code or Pass Phrase.
Enter numbers directly using the number
buttons on your remote control. Enter
letters by selecting a letter with the
▲▼◀▶ buttons, and then pressing the
v button.
11. When finished, select Done at the right of
the screen, and then press the v button.
The product verifies the network connection
and then connects to the network.
12. After the product verifies the network,
select OK, and then press the v button.
ĞĞ

WPS(PBC)

1.

In the Home screen, select Settings, and
then press the v button.

2.

Select Network, and then press the v
button.
Select Network Settings, and then press
the v button.
Select Wireless in the Network Settings
screen, and then press the v button.

3.

On the bottom of the screen, select IP
Settings, and then press the v button.
The IP Settings screen appears.

3.

4.

Select the IP Setting field, and then press
the v button.
Select Enter manually in the IP Setting
field, and then press the v button.

5.

Press the ▲ button on your remote, and
then press the ▶ button to select the
WPS(PBC).

6.

Press the v button on your remote. The
"Press the PBC button on your wireless
router within the next two minutes."
message appears.

7.

Press the WPS(PBC) button on your
router within two minutes. Your product
automatically acquires all the network
settings values it needs and connects to
your network.
The Network Status screen appears. The
product connects to the network after the
network connection is verified.

5.
6.

Select a value to enter (IP Address, for
example), and then press v button.
Use the number keypad on your remote
control to enter the numbers for the value.
You can also enter numbers using the
▲▼ buttons. Use the ◀▶ buttons on the
remote control to move from entry field
to entry field within a value. When done
with one value, press the v button.

7.

Press the ▲ or ▼ button to move to
another value, and then enter the
numbers for that value following the
instructions in Step 6.

8.

Repeat Steps 6 and 7 until you have filled
in all values.
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||NOTE |
\\ To view the password as you enter it, use the arrow
buttons to select Show Password on the right side,
and then press v button.

Settings
ĞĞ

WPS(PIN)

Before you begin, open the router's setup
menu on your PC and access the screen with
the WPS PIN entry field.

1.

Turn on the Wi-Fi direct device and
activate its Wi-Fi Direct function.

2.

In the Home screen, select Settings, and
then press the v button.

1.

In the Home screen, select Settings, and
then press the v button.

3.

Select Network, and then press the v
button.

2.

Select Network, and then press the v
button.

4.

3.

Select Network Settings, and then press
the v button.
Select Wireless in the Network Settings
screen, and then press the v button.
The product searches for and then displays
a list of the available networks.

Select Wi-Fi Direct, and then press the v
button.
The Wi-Fi Direct devices that you can
connect appear.

4.

5.

Select the desired network, and then press
the ▶ button.

6.

Select the WPS(PIN), and then press the
v button. The PIN pop-up appears.
Enter the PIN into the WPS PIN entry field
in the router's Set Up screen and then
save the the screen.

7.

||NOTE |

\\ Contact the manufacturer of the router for
instructions explaining how to access the route's Set
Up screens or refer to the router's user's manual.
\\ For a WPS connection, set your wireless router's
security encryption method to AES. WPS connections
do not support WEP security encryption.

Wi-Fi Direct
The Wi-Fi Direct function allows you to
connect Wi-Fi Direct devices to the product
and each other using a peer-to-peer network,
without a wireless router.
||NOTE |
\\ Bluetooth transmissions can interfere with the WiFi Direct signal. Before you use the Wi-Fi Direct
function, we strongly recommend that you turn off
the Bluetooth function of any active mobile device.
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||NOTE |
\\ The current wired or wireless network connection
will be disconnected when you use the Wi-Fi Direct
function.
\\ Text files, such as files with a .TXT or .DOC
extension, will not display when you are using the
Wi-Fi Direct function.

Upgrading Software
The Software Update menu allows you to
upgrade the product's software for performance
improvements or additional services.
• Never turn the product off or back on manually
during the update process.
1.

In the Home screen, select the Settings,
and then press the v button.

2.

Select Support, and then press the v
button.

3.

Select Software Update, and then press
the v button.
To download update software and update
now, select Update Now, and then press
the v button.

4.

5.
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To let the product download update
software automatically when available,
select Auto Update, and then press the
v button. See "Auto Update" on page
25 for details.

\\ Samsung Electronics shall takes no legal
responsibility for product malfunction caused by
an unstable Internet connection or consumer
negligence during a software Update.
\\ If you want to cancel the upgrade while the upgrade
software is downloading, press the v button.
\\ When a system upgrade is in progress, "UPDATE" is
displayed on the front panel.

Auto Update
You can set the Auto Update function so that
the product downloads new upgrade software
when it is in Auto Update mode.
In Auto Update mode, the product is off, but
its Internet connection is active. This allows
the product to download upgrade software
automatically, when you are not using it.
1.

Press the ▲▼ buttons to select Auto
Update, and then press the v button.

2.

Select On. Then the product will be
updated automatically after power off. If
it downloads new upgrade software, the
product will ask you if you want to install
it when you turn the product on.

Update Now
You can use Update Now to update the
software through your network connection
or by using a USB flash drive. The network
instructions are below. The USB flash drive
instructions are on the next page.
1.

Select Update Now, and then press the
v button.
The Update now pop-up appears.

2.

The product searches on line for the latest
software version.

||NOTE |
\\ To use the Auto Update Mode Upgrade function,
your product must be connected to the Internet.

Update by USB
To upgrade by USB, follow these steps:
1.

Visit www.samsung.com.
Click SUPPORT on the top right of the
page.

3.

If it finds a new version, the Update
Request pop-up appears.

2.

4.

Select OK. The product upgrades the
software, turns off, and then turns on
automatically.

3.

5.

If you do not select OK or Cancel in one
minute, the product stores the new
upgrade software. You can upgrade the
software later using Auto Update.

Enter the product's model number into
the search field. As you enter the model
number, a drop down will display products
that match the model number.

4.

Left click your product's model number in
the drop down list.

5.

6.

If you select Cancel, the product cancels
the upgrade.

On the page that appears, scroll down
to and then click Firmware Manuals &
Downloads.

6.

Click Firmware in the center of the page.

7.

Click the ZIP button in the File column on
the right side of the page.

8.

Click Send in the first pop-up that
appears. Click OK in the second pop-up
to download and save the firmware file to
your PC.

||NOTE |
\\ When the system upgrade is done, check the
software details in the Product Information section
of the Contact Samsung screen.
\\ Do not turn off the product during the Software
Update. It may cause the product to malfunction.
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||NOTE |
\\ The upgrade is complete when the product turns
off, and then turns on again by itself.

Settings
9.

Unzip the zip archive to your computer.
You should have a single folder with the
same name as the zip file.

10. Copy the folder to a USB flash drive.
11. Make sure no disc is inserted in the
product, and then insert the USB flash
drive into the USB port of the product.
12. In the product’s menu, go to Settings >
Support > Software Update.
13. Select Update Now.
14. The product searches for the software on
the USB drive. When it finds the software,
the Update Request pop-up appears.
15. Select OK. The product upgrades the
software, turns off, and then turns on
automatically.
||NOTE |
\\ There should be no disc in the product when you
upgrade the software using the USB jack.
\\ When the system upgrade is done, check the
software details in the Product Information section
of the Contact Samsung screen.
\\ Do not turn off the product during the Software
Update.
It may cause the product to malfunction.
\\ Software Updates using the USB jack must be
performed with a USB flash memory stick only.
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Media Play

||NOTE |
\\ You can play contents on your PC using
other programs compatible with Allshare
network software, however, we recommend
that you use Allshare network software.

Playing Commercial Discs
1.

Press the 8 button to open the disc tray.

2.

Place a disc gently into the disc tray with
the disc’s label facing up.

• Cleaning Discs
-- If you get fingerprints or dirt
on a disc, clean it with a mild
detergent diluted in water and
wipe with a soft cloth.
-- When cleaning, wipe gently from the
inside to the outside of the disc.
• Disc Storage
`` Do not keep in direct sunlight.
`` Keep in a cool ventilated area.
`` Keep in a clean protection jacket and
store vertically.

Playing Photos, Videos, and Music
(Multimedia)
You can play media content saved on a USB
device, smartphone, camera, computer, or
cloud service on the product.
||NOTE |
\\ However, you cannot play media content
if the content or the storage device are not
supported by the product.
\\ Backup important files before connecting
a USB device. Samsung shall not be held
responsible for damaged or lost files.

3.

Press the 8 button to close the disc tray.
Playback starts automatically.

4.

If playback does not start automatically,
press the 6 button on the remote
control.

Disc Storage & Management
• Holding Discs
-- Fingerprints or scratches on
a disc may reduce sound and
picture quality or cause skipping.
-- Avoid touching the surface of a disc where
data has been recorded.
-- Hold the disc by the edges so that
fingerprints will not get on the surface.
-- Do not stick paper or tape on the disc.
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Playing Media Content Saved on a USB
Device
1.

Connect your USB device to the product.

2.

Press the HOME button and select Storage
in the Multimedia panel. The USB devices
connected to the product are listed.

3.

Select the device you wish to connect to.
The folders and files in the selected USB
are listed.

4.

Select the media content you wish to play
from the list. The media content plays.

||NOTE |
\\ Alternatively, move to the media content to play and
press the 6 button to play the content.
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Your product can play content located on Bluray/DVD/CD discs, USB devices, and PCs. To
play content located on your PC, you must
connect your PC and the product to your
network and Visit the http://link.samsung.com
site to download and install the Samsung-link
program.

Media Play
5.

To exit, press the 5 button or RETURN
button.

||NOTE |
\\ If you connect a USB device to the product while
watching the product, a popup window appears on
the screen so that you can easily navigate the folders
and files of the USB device.

Playing Media Content Saved in a
Computer/Mobile Device
You can play media content on the product
with a computer or mobile device connected
to the same network as the product.
||NOTE |
\\ Only available with Samsung phones supporting
DLNA functionality.
\\ Samsung Link software should have been installed
on the computer. The mobile device should
support Samsung Link. For more information, visit
Samsung’s content and service portal at http://
link.samsung.com.
\\ You may experience compatibility issues when
attempting to play media files via a third-party DLNA
server.
\\ However, the content shared by a computer or
a mobile device may not play depending on the
encoding type and file format of the content. In
addition, some functions may not be available.
\\ The media content may not smoothly play
depending on the network status. If this is the case,
use a USB storage device.
1.

Connect the smart device and product.

2.

Press the HOME button and select
Network Device in the Multimedia panel.
Storages devices connected to the same
network of the product are listed.

3.

Select a desired storage device. The
folders and files shared by the selected
storage device are listed.

4.

Select the media content you wish to play
from the list. The media content plays.

Allowing Connection with a Mobile
Device
(HOME → Settings → Network → Multimedia
Device Settings)
To play the media content stored on a mobile
device, you must allow the connection
between the mobile device and the product.
||NOTE |
\\ You can connect to a mobile device on any DLNA
DMC device. DLNA DMC function enables users to
connect a mobile device to the product, search for
media content, and control play operations on the
product.
1.

Navigate to Settings > Network and select
Multimedia Device Settings. The mobile
devices connected to the same network as
the product are listed.

2.

Allow connection with the device you
wish to connect to the product. You can
only play media files from devices that
have been allowed to connect to the
product.

||NOTE |
\\ If a mobile device requests the media content to
play, the connection confirmation window appears
on the product so that you can easily connect a
mobile device.

Playing a Disc with User Recorded
Content
You can play multimedia files you have
recorded on Blu-ray, DVD, or CD discs.
1.

Place a user recorded disc into the disc
tray with the disc’s label facing up, and
then close the tray. The Device Connected
pop-up appears.

2.

Use the ▲▼ buttons to select the type of
content you want to view or play All Content, Photos, Videos or Music - and
then press the v button.

||NOTE |
\\ Alternatively, move to the media content to play and
press the 6 button to play the content.
5.

To exit, press the 5 button or RETURN
button.
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3.

A screen appears listing the contents of
the disc. Depending on how the contents
are arranged, you will see either folders,
individual files, or both.

4.

If necessary, use the ▲▼◀▶ buttons to
select a folder, and then press the v
button.

5.

Use the ▲▼◀▶ buttons to select a file
to view or play, and then press the v
button.

6.

7.

Press the RETURN button one or more
times to exit a current screen, exit a folder,
or to return to the Home screen.
Press the EXIT button to return directly to
the Home Screen.
Go to pages 27~36 for instructions that
explain how to control playback of videos,
music, and pictures on a disc.

Playing Media Content Saved in a
Cloud Service
Cloud service saves user content such as
photos, videos, and music files on a server
so that it can be played on the product
connected to the network. You can view the
media content saved in a cloud service such as
Dropbox and SkyDrive on the product.

2.

Select a desired cloud service. The folders
and files in the selected cloud service are
listed.

3.

Select media content you wish to play
from the list. The media content plays.

||NOTE |
\\ Alternatively, move to the media content to play and
press the 6 button to play the content.
4.

||NOTE |
\\ A Samsung smart device or a PC installed with the
Samsung Link app can be connected to the Blu-ray
product through a remote network.
\\ To connect devices through a remote network, the
same Samsung Account should be used to log in for
both this Blu-ray product and the device running the
Samsung Link app.
\\ For more information, visit the Samsung Content &
Service portal (http://link.samsung.com).

Samsung Link
For more information, visit the Samsung Content
& Service portal (http://link.samsung.com).
||NOTE |
\\ You may experience compatibility issues when
attempting to play media files via a third-party DLNA
server.

||NOTE |
\\ To play the content in a cloud service, you must log
into your Samsung account and link the Samsung
account to the cloud service account. For the
information about linking your Samsung account to
a cloud service account, see page 46.
1.

Press the HOME button and select Cloud
Service in the MULTIMEDIA panel. The
cloud services linked with your Samsung
account appears.
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To exit, press the 5 button or RETURN
button.
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||NOTE |
\\ Even though the product will display folders for all
content types, it will only display files of the Content
Type you selected in Step 2. For example, if you
selected music, you will only be able to see music
files. You can change this selection by returning to
the MULTIMEDIA screen and repeating Step 2.

Media Play
SOURCE

Controlling Video Playback
VOL

VOL

1

2

3

4

5

6

7

8

– + VOL
+ –of video content located on a Disc, USB, mobile device or PC.
You can control the VOL
playback
Depending on the disc or TVcontents, some of the functions described in this manual may not be available.

Buttons on the Remote Control used for Video Playback
DISC MENU

9

0

SMART

POPUP

HOME

HOME

APPS

TOOLS buttons
INFO
Playback related

The product does not play sound in Search,
Slow or Step mode.
speed
• To return to normal
RETURN
EXITplayback, press
the 6 button.
6 button

A

B

C

D

PANDORA

DIGITAL

SUBTITLE

INPUT

DISC MENU
button

During playback, press this button to
display the Disc menu.

TITLE MENU
button

During playback, press this button to
display the Title menu.
• If your disc has a playlist, press the
View to go to the playlist.

POPUP MENU During playback, press this button to
button
display the Popup menu.

Using the Settings Menu (During the
Playback)

StartsAUDIO
playback.
SUBTITLE LIGHT

SEARCH

Using the disc menu, title menu, popup
menu, and title list

REPEAT

HUB





TITLE MENU

5 button

Stops playback.

7 button

Pauses playback.

Fast Motion
Play

During playback, press the 3 or 4
button.
Each time you press the 3 or 4
button, the playback speed will
change.

Slow Motion
Play

In pause mode, press the 4 button.
Each time you press the 4 button,
the playback speed will change.

Step Motion
Play

In pause mode, press the 7 button.
Each time you press the 7 button, a
new frame appears.

Skip Motion
Play

During playback, press the 1 or 2
button.
Each time you press 1 or 2 button,
the disc moves to the previous or next
chapter or file.

During playback or in pause mode, press the
TOOLS button.
Use the ▲▼◀▶ buttons to select the
button, and then press the E button.
Play from the
Beginning

Select to return to the beginning of
the movie, and then press the v
button.
-- Search Titles : If there is more
than one movie on the disc or
device, select to start a different
title.
1. Select Search Titles, and
then press the v button.

Select Scene

2. Use the ▲▼ buttons to
select a title, and then
press the v button.
-- Chapter Search : Select to play
the chapter of your choice.
1. Select Chapter Search, and
then press the v button.
2. Use the ▲▼ buttons to
select a chapter, and then
press the v button.
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1. Select Search Time Bar, and
then press the v button.
2. Using the number buttons,
enter the time point you
want to go to, and then
press the v button.

Select Scene

||NOTE |
\\ You can also use the ◀▶
buttons to advance or rewind
the movie. The movie advances
or rewinds one minute each
time you press the ◀▶ buttons.
\\ If the index information in the
file is damaged or the file does
not support indexing, you will
not be able to use the Select
Scene function.

\\ If you run files on network
device after you have connected
the player to a computer on
your network, Select Scene may
not work.
Use the 3D menu when playing a
3D file.

Search

-- Search Scene : You can use the
Search Scene function during
playback to view or start a movie
from the scene of your choice.
-- Search Titles : If there is more
than one movie on the disc or
device, select to start a different
title.
-- Search Time Bar : Select to play
the movie from a selected time
point.

Subtitle Settings

Lets you set the desired subtitle
options.

Repeat mode

Lets you repeat a title, chapter, or
specific section.

Rotate

Lets you rotate the picture.

Full Screen

Lets you set the size of the video image.

Picture Mode

||NOTE |
\\ The 3D menu becomes available
only when you are playing a 3D
video file.
3D

\\ When playing a 3D video, set
the player to Side by Side or Top
and Bottom in 3D Settings so
that the player's settings match
the 3D content format.
\\ If you move to the Home or
Smart Hub Home screen while
in 3D mode, the product will
switch to 2D automatically.
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Lets you set the picture mode.
-- Dynamic : Increases sharpness
and brightness.
-- Standard : Choose this setting
for most viewing applications.
-- Movie : The best setting for
watching movies.
-- User : Lets you adjust the
sharpness and noise reduction
function respectively.
||NOTE |
\\ When you use the BD wise function,
this menu will not appear.

Audio

Use to set the desired audio language.

Audio Sync

Select to set the audio sync.

Subtitle

Use to set the desired subtitle
language.

Angle

Lets you view a scene from another
angle. The Angle option displays the
number of angles available to view.
When a Blu-ray Disc/DVD contains
multiple angles of a particular
scene, you can change angle.

Information

Lets you view video file information.
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-- Search Time Bar : Select to play
the movie from a selected time
point.

Media Play
BONUSVIEW
Video
BONUSVIEW
Audio

Controlling Music Playback
Use to set the desired bonusview
option.

||NOTE |
\\ Depending on the disc or storage device, the
Settings menu may differ.

You can control the playback of music content
located on a Disc, USB, mobile device or PC.
Depending on the disc or contents, some of
the functions described in this manual may not
be available.
SOURCE

\\ Video files with high bitrates of 20Mbps or more
strain the product's capabilities and may stop playing
during playback.

Using the View & Options Menus

Buttons on the Remote Control used
for Music Playback
– + VOL
+–
VOL
VOL

1

Using the View Menu

2

4

5

7

8

DISC MENU

On a file screen containing video files, select
and then press the v button.

Date

1

Groups all the the photo files on
the media or storage device by
date. Click a group to see the
videos in that group.

Title

Displays all the video files on the
media or storage device by title.

Folder

Displays all the folders on the media
or storage device in alphabetical
order.

||NOTE |
\\ Depending on the disc or storage device, the View
menu may differ or not appear.

Using the Options Menu
On a file screen containing video files, select
and then press the v button.
Play Selected

Play Selected lets you select specific
file to play. It works essentially the
same for all media.

Send

Select Send to upload selected files
to a web site (Picasa, Facebook etc)
or device. To use Send, you need
to establish an account with the
on-line site, and then log in using
the Log In function. See "Using the
Send Function" on page 37.
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2

3

SMART

0

VOL

TV

6
9

TITLE MENU

HOME

HOME

3

HUB

POPUP

REPEAT

APPS

TOOLS

4
5
6

INFO

1

NUMBER buttons : Press the number of a
track. The selected track is played.

2

12 button : Moves to the previous/next
RETURN
EXIT
track.

3

5 button :AStopsB a track.
C
SEARCH

D

AUDIO SUBTITLE LIGHT

4

Fast Play (Audio CD (CD-DA) only)
During playback, press the 3 or 4 button.
Each time you press the 3 or 4 button, the
playback speed will change.

5

7 button : Pauses a track.

6

6 button : Plays the currently selected track.

PANDORA

DIGITAL

SUBTITLE

INPUT

||NOTE |
\\ If you don't press a button within five seconds of
inserting an Audio CD, the screen is displayed in Full
Screen mode.
To go back to the Play List screen, press the RETURN
button on the remote control.
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Using the Options Menu (During the
Playback)

Using the View Menu
On the playback screen, select the
and then press the v button.

button

Save as Playlist

Select to save as playlist.
Track

Play Selected

Lets you create a playlist by
selecting specific tracks to play. It
works essentially the same way for
all media. See "Creating a Playlist
on an Audio CD" on page 34.

Displays all the music tracks on
the media or storage device in
alphabetical order.

Album

Displays all music on the media or
storage device by album

The Ripping function converts CD
audio to the mp3 format and saves
the converted files on a USB device
or a mobile device connected to the
product. See "Ripping" on pages
34~35.

Artist

Displays all the the music files on
the media or storage device by artis

Genre

Displays all the music on the media
or storage device by genre.

Folder

Displays all the folders on the media
or storage device.

Ripping

Information

Select to see the (Contents)
information.

||NOTE |
\\ Depending on the disc or storage device, the View
menu may differ or not appear.

||NOTE |
\\ Depending on the disc or storage device, the
Settings menu may differ or not appear.

Using the Options Menu
On playback screen or a file screen containing
and then press the v
music files, select
button.

Play Selected

Play Selected lets you select specific
tract to play. It works essentially the
same for all media.
See the "Repeating tracks on an
Audio CD" on page 34.

Send

Select to send selected files to
other devices. See "Using the Send
Function" on page 37.

Encoding

Select to manage the text encoding
options.

||NOTE |
\\ Depending on the disc or storage device, the
Options menu may differ or not appear.
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On the music file playback screen, use the
button, and
▲▼◀▶ buttons to select the
then press the v button.

Using the View & Options Menus (On a
file screen)

Media Play
Repeating Tracks on an Audio CD

4.

You can set the product to repeat tracks on an
audio CD (CD-DA/MP3).

Repeat Step 3 to select and check
additional tracks.

5.

To remove a track from the list, move to
the track, and then press the v button
again.
The check on the track is removed.

6.

When done, press the ▲▼ button to
select Play, and then press the v button.
The Music Playback screen reappears
listing only the tracks you checked. The
selected tracks play automatically.

1.

2.

On the Playback screen, use the ▲▼◀▶
in the lower left
buttons to select
corner of the screen, and then press the
v button.
Use the ▲▼ to select the repeat mode
you want - Off, One Song, or All - and
then press the v button.

TRACK 001
00:00:39 00:02:38

TRACK 001

00:43

TRACK 002

03:56

TRACK 003

04:41

TRACK 004

04:02

TRACK 005

03:43

TRACK 006

03:40

TRACK 007

04:06

TRACK 008

03:52

TRACK 009

03:04

TRACK 010

04:02

Shuffling Tracks on an Audio CD
You can set the product to play tracks on an
audio CD (CD-DA/MP3) at random.
1.

On the Playback screen, use the ▲▼◀▶
in the lower left
buttons to select
corner of the screen, and then press the
v button.

2.

Use the ▲▼ to set the Shuffle mode On
or Off, and then press the v button.

Creating a Playlist from an Audio CD
1.

With the Playback screen displayed, select
button, and then press the v
the
button. The Settings menu appears.

2.

Use the ▲▼ buttons to select Play
Selected, and then press the v button.
The Selection Play screen appears.

3.

Use the ▲▼ buttons to select a track,
and then press the v button. A check
appears to the left of the track.
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||NOTE |
\\ You can create a playlist with up to 99 tracks on
Audio CDs (CD-DA).
\\ If you have created a playlist, Play Selected is
replaced by Edit Playlist on the Settings menu.
\\ On the Selection Play screen, you can also choose
Select All, Clear All, and Cancel.
-- Use Select All to select all tracks. This cancels your
individual track selections. When you press the
RETURN button on your remote control or select
the Play button, and then press the v button, all
tracks will appear on the Music Playback screen,
and the product will begin to play all tracks from
Track 001.
-- Use Clear All to deselect all selected tracks at
once. Then, select individual tracks or use Select
All to select all the tracks, and then press the
RETURN button on your remote control. If you do
not use Select All or select individual tracks, the
Playlist will not change.
-- Cancel cancels any changes you made on the Play
Select screen. When you return to the Playback
screen, the Playlist will be unchanged.

Ripping
1.

Insert a USB device into the USB jack on
the front of the product.

2.

With the Playback screen displayed, select
button and then press the v
the
button. The Settings menu appears.

3.

Use the ▲▼ buttons to select Ripping,
and then press the v button. The
Ripping screen appears.

English

Use the ▲▼ buttons to select a track,
and then press the v button. A check
appears to the left of the track.

5.

Repeat Step 3 to select and check
additional tracks.

6.

To remove a track from the list, move to
the track, and then press the v button
again.
The check on the track is removed.

7.

When done, select the Rip button using
the ▲▼ buttons, and then press the v
button. The Rip pop-up appears.

8.

Use the ▲▼ buttons to select the device
to store the ripped files to, and then press
the v button.

||NOTE |
\\ Do not disconnect the device while ripping is in
progress.
9.

If you want to cancel ripping, press the
v button and then select Yes. Select No
to continue ripping.

Playing Photo Contents
You can play photo contents located on a
DVD, USB, mobile device or PC.

Using the Tools Menu (During Playback)
During playback or in pause mode, press the
TOOLS button.
Use the ▲▼◀▶ buttons to select the
button, and then press the v button.

Slideshow
Settings

Select to change the Slide Show
settings.
-- Speed : Select to set the slide
show speed.
-- Effect : Select to set the slide
show effect.

Rotate

Select to rotate the picture. (This
can rotate the picture either
clockwise or counter clockwise.)

Zoom

Select to enlarge the current
picture. (Enlarge up to 4 times)

10. When ripping is complete, the
"Successfully Ripped." message appears.
Press the v button.
11. Press the RETURN button or select Cancel,
and then press the v button to go back
to the Playback screen.
||NOTE |
\\ This function does not work with DTS Audio CD.

Picture Mode

\\ This function may not be supported by some discs.
\\ Ripping encodes music into the .mp3 format at
192kbps.

||NOTE |
\\ This menu can not be displayed
when you use the BD Wise
function.

\\ On the Ripping screen, you can also choose Select
All and Clear All.
\\ Use Select All to select all tracks and press the v
button. This cancels your individual track selections.
\\ Use Clear All to deselect all selected tracks at once.
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Select to set the picture mode.
-- Dynamic : Choose this setting to
increase Sharpness.
-- Standard : Choose this setting
for most viewing applications.
-- Movie : This is the best setting
for watching movies.
-- User : Lets you adjust the
sharpness and noise reduction
function respectively.

Background
Music

Select to listen to music while
viewing a slide show.

Send

Select to send the selected file to
other devices.

Information

Select to see the (Contents)
information.
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4.

Media Play
||NOTE |
\\ Depending on the disc or storage device, the Tools
menu may differ. All options may not be displayed.
\\ To enable the background music function, the
photo file must be in the same storage media
as the music file.
Note that the sound quality can be affected
by the bitrate of the MP3 file, the size of the
photo, and the encoding method.

Using the Options Menu
On a file screen containing photo files, select
and press the v button.
the

Slide show

Starts the slide show. Shows all the
files in the current folder, one after
another. If you want to create a
slide show with a selected group of
photos, see Play Selected below.

Play Selected

Play Selected lets you select specific
photo to see. It works essentially
the same for all media.
See "Creating a Playlist from
an Audio CD" on page 34 for
instructions.

Send

Select Send to upload selected files
to a web site (Picasa, Facebook etc)
or device. To use Send, you need to
establish an account with the online site, and then log in using the
Log In function.
See "Using the Send Function" on
page 37.

\\ You can't enlarge the subtitle and PG graphic in the
full screen mode.

Using the View & Options Menus
Using the View Menu
On a file screen containing photo files, select
button and then press the v button.
the

Date

Groups all the the photo files on
the media or storage device by
date. Click a group to see the
photos in that group.

Title

Displays all the photo files on the
media or storage device by title.

Folder

Displays all the folders on the media
or storage device.

||NOTE |
\\ Depending on the disc or storage device, the View
menu may differ or not appear.
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||NOTE |
\\ Depending on the disc or storage device, the
Settings menu may differ or not appear.
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Send files

Contents

DISC/
Network
Device/
Cloud
Service 
USB

DISC/USB/
Cloud
Service 
Network
Device

DISC/USB/
Network
Device
 Cloud
Service

Music

Supported

Supported

Supported

Photos

Supported

Supported

Supported

Videos

Supported

Supported

Supported

Select a destination, and then press the
v button.

8.

If you are sending the files to an on-line
site, the site starts. Log in and follow the
directions on the screen.

||NOTE |
\\ To send files to an on-line site you must have an
account with that site.

• Disc (CD-DA/CD-R/CD-RW, DVD±R(Finalise)/
DVD+RW/DVD-RW(Finalise))  USB
• PTP USB is not available when you copy to
USB.

Using the Send Function
You can upload files to an Network Device,
Cloud Service or a device.
1.

With the Videos, Music or Photos file
screen displayed, select the TOOLS button,
and then press the
button. The Options menu appears.

2.

Use the ▲▼ buttons to select Send, and
then press the v button. The Selection
screen appears.

3.

Use the ▲▼ buttons to select a file,
and then press the v button. A check
appears to the left of the file.

4.

Repeat Step 3 to select and check
additional file.

5.

To remove a file from the list, move to the
file, and then press the v button again.
The check on the picture is removed.

6.

When done, press the ▲▼ button to
select Send, and then press the v
button.
The Send pop-up appears listing the online sites (Picassa, Facebook, etc.) or
devices that you can send the photos to.
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Copying Videos, Music or Photos

7.

Network Services
You can enjoy various network services such as
streaming video or on-line apps by connecting
the product to your network.

7.

Enter a password, your first name, and
last name in the same fashion.

8.

Select the Date of Birth field, and then
select numbers using the up and down
arrow buttons or pressing numbers on
your remote. Press the v button when
done.

9.

After you have finished with all the ields,
press the ▶ button, and then press the v
button. Connecting appears, and then the
account confirmation message.

To use network services, you must first:
1.

Connect the product to a network.
(See page 14)

2.

Configure the network settings.
(See pages 21~24)

10. Press the v button. The Set Profile
Picture screen appears.

Creating a Samsung Account
Create a Samsung account so you can take
advantage of all Samsung has to offer on
line. Set up accounts for each household
member so each member can access their
own accounts on Facebook, Twitter, etc. You
also need a Samsung account if you want to
download for-pay apps and rent movies.
1.

On the Home screen, press the
The Log In screen appears.

2.

Select Create Account on the bottom
right, and then press the v button.
The Samsung account terms & conditions,
privacy policy screen appears.

button.

||NOTE |
\\ Samsung sends a confirming e-mail to the address
you entered. You must open the e-mail and respond
as requested to finalize your account.
11. Select a picture to identify your account,
and then press the v button. The
Account Created screen appears.
12. Press the v button. The Home screen
appears.

Before Using Apps

3.

Press the v button to agree, press the
▶ button, and then press the v button.
The Create a Account screen appears.

If you haven’t set up Smart Hub, when you use
Apps for the first time, the product will ask you
to perform the Smart Hub set up procedure.

4.

Select the ID field, and then press the v
button. The keyboard pop-up appears.

1.

5.

Enter your e-mail address using the
keyboard. Use the arrow buttons to move
from character to character.
Press v to select a character. Select
the Caps button on the left to enter
capitals. Select the 123#& button to select
additional symbols.

On the Home screen, select either APPS,
and then press the v button. If you have
selected APPS, go to Step 4.

2.

If you selected APPS, the Smart Hub popup appears asking if you want to set up
Smart Hub. Select Yes, and then press the
v button. The Welcome screen appears.

6.

When finished, select the Done button
on the keyboard, and then press the v
button. The Create screen reappears.
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Select Start, and then press the v
button. The Terms and Policy screen
appears.

4.

On the Additional Services, Terms and
Conditions and Choices screen, you must
review and agree to both the Smart Hub
Terms and Conditions and the Privacy
Policy to use Smart Hub.

5.

Scroll down, and then click the View
details buttons to review the full
documents.

||NOTE |
\\ You do not need to consent to the Supplemental
Privacy Notice, but one or more Smart TV features or
functionalities may not be available if you do not.
6.

Select I agree to all, and then press the
v button. The Setup Complete screen
appears. Press the v button.

Using Movies & TV Shows
If you haven’t set up Smart Hub, when you
use Movies & TV Shows for the first time, the
product will ask you to perform the Smart Hub
set up procedure. You can stream Movies & TV
Shows and view them on your TV.

Recommended

Featured

3.

To watch a selection, select listed apps,
and then press the v button.

||NOTE |
\\ The listed apps appears if you have not installed any
of the movie apps you could use to watch the movie
or TV show you selected. If none of these apps are
installed on your Blu-ray player, select one of the
apps, and then press the v button. You will be
asked if you want to install the app. Select Install,
press the v button, and then follow the directions
that appear on the screen to install the app.
4.

Follow the directions on the screen to start
the movie.

||NOTE |
\\ Contents items and the corresponding bottom menu
in Movies and TV Shows differ between countries.

MOVIES & TV SHOWS

Favourites

2-1. Alternately, select Movies or TV Shows
and then press the v button.
On the page that appears, use the
▲▼◀▶ buttons to select a show or
movie, and then press the v button.
On the Movies or TV Shows screen, you
can also select What’s New or Genres to
see more available shows or Films. On the
Genres screen, use the ▲▼◀▶ buttons
to select a desired Genres, and then press
the v button.
To make a selection on a page displaying
Movies and TV Shows, use the ▲▼◀▶
buttons to make a selection, and then
press the v button.

Movies

TV Shows

Trailers

Trending

1.

On the Home screen, select MOVIES & TV
SHOWS, and then press the v button.

2.

Select one of the Recommended Movies,
and then press the v button. The page
for that movie appears. Use the ▼ button
to go to the bottom of the screen.
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\\ When you activate Movies and TV Shows for the
first time, the listed apps may not be displayed.
The listed apps is displayed after you download a
video contents App for use.
If the listed apps button is not displayed, you cannot
watch contents.
\\ Favorites will not appear unless you have tagged
one or more films or TV shows as a favorite. To tag
a movie or show as a favorite, select the show. The
Detail screen appears. Select the heart symbol, and
then press the v button.
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3.

Network Services
The first time you open the Apps screen, the
Blu-ray player automatically downloads a
group of free apps. Once these apps have
been downloaded, they appear on the Apps
screen.
To see additional apps, select Most Popular,
What's new, or Categories on the bottom of
the screen, and then press the v button.
Most Popular displays the most popular apps,
What's new the newest. Categories displays a
series of icons representing categories such as
Videos, Games, and Sports. Select a category
icon, and then press the v button. The Bluray player displays the apps in that category.

Using Apps
You can download applications from the
Internet, and access various application
and view them on your TV. To access some
applications, you need to have a Samsung
account.

The Apps Screen at a Glance

1

2

APPS
Recommended

1

2

3

4

5

2

3

4

5

My Apps (1 / 1)

WebBrowser

Downloading an App

Most Popular

6

What's new

7

8

9

10

1.

Select Most Popular, What's New, or
Categories, and then press the v button.

2.

If you selected Categories, select a
category icon, and then press the v
button. Otherwise, go to Step 3.

Categories

3
1

Recommended : Displays recommended
contents managed by Samsung. You cannot
delete Recommended Apps.

2

My Apps : Displays your personal gallery of
applications modifiable on the My Apps screen.

3

Most Popular, What’s new and Categories :
Select to view and download additional apps.

||NOTE |
\\ On the Most Popular, What's new, and Categories
screens, a green arrow is displayed on apps you have
already downloaded.
3.

Select an app you want to download,
and then press the v button. The Detail
Information screen for the apps appears.

4.

Select the Download button on the
screen, and then press the v button.
Download changes to Cancel and the app
begins to download.

5.

If you want to cancel the download, select
Cancel, and then press the v button.

6.

When the download is complete,
Cancel changes to Play. Select Play, and
then press the v button to start the
application. Alternately, press the RETURN
button until the Apps screen reappears.
The app you downloaded will be displayed
on the Apps screen under My Apps.

||NOTE |
\\ If the App cannot be downloaded due to insufficient
remaining internal memory, connect a USB storage
device and try again.
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Starting an Application

View Detail

Select APPS on the Home screen, and
then press the v button.

2.

On the APPS screen, use the ▲▼◀▶
buttons to select an app, and then press
the v button. The app starts.

The Option Menu

On the My Apps screen, select the app
you want to see detailed information
for, and then press the v button for 3
seconds. The Option menu appears.

2.

Select View Detail, and then press the v
button.

Update Apps

Move
1.

1.

On the My Apps screen, select the app
you want to move and then press the v
button for 3 seconds. The Option menu
appears.

2.

Select Move, and then press the v
button.

3.

Use the ▲▼◀▶ buttons to move the app.

4.

When the app is where you want it, press
the v or EXIT button.

Delete
1.

On the My Apps screen, select the app
you want to delete and then press the v
button for 3 seconds. The Option menu
appears.

2.

Select Delete, and then press the v
button.

3.

Use the ◀▶ buttons to select OK, and
then press the v button.

1.

On the My Apps screen, select any app,
and then press the v button for 3
seconds. The Option menu appears.

2.

Select Update Apps, and then press the
v button.

3.

The Update Apps screens lists all the apps
that have updates available. Select each
app you want to update, and then press
the v button. You can also choose Select
All to update all the apps listed.

4.

Select Update, and then press the v
button.

Delete Multiple
1.

On the My Apps screen, select an app you
want to delete and then press the v
button for 3 seconds. The Options menu
appears.

2.

Select Delete Multiple, and then press the
v button.

3.

Use the ▲▼◀▶ buttons to select apps
you want to delete, and then press the
v button.

4.

Use the ▼ buttons to select Delete, and
then press the v button.
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Network Services
Screen mirroring

Using the Web Browser

The Screen mirroring function lets you view the
screen of your smart phone or android tablet
on the TV you have connected to the product.
1.

In the Home screen, select Screen
mirroring, and then press the v button.

2.

Launch AllShare Cast or Screen mirroring
on your device.

3.

On your device, find the name of the
product in the list of available devices and
then select it.

4.

The TV displays a connecting message (for
example, Connecting to Android_92gb...)
and then displays the connected message.

5.

In a few moments, the screen of your
device appears on the TV screen.

6.

To stop Screen Mirroring, press the EXIT or
RETURN button on the remote control, or
exit the Screen Mirroring function on your
smart phone.

||NOTE |
\\ You can connect to a device that supports AllShare
Cast. Note that all devices that have AllShare Cast
may not be fully supported, depending on the
manufacturer. For further information on mobile
connection support, refer to the manufacturer’s web
site.

You can access the Internet using the Web
Browser application.
Select WebBrowser on the Home screen, and
then press the v button.
||NOTE |
\\ When you run the Web Browser with the product
connected by HDMI to a BD Wise compatible TV
- and BD Wise is on - the browser is maximized to
fill the screen and the TV's resolution is set to the
optimal resolution automatically.
\\ The Web Browser is not compatible with Java
applications.
\\ If you attempt to download a file, and the file
cannot be saved, an error message will appear.
\\ E-commerce (purchasing products online) is not
supported.
\\ ActiveX is not supported.
\\ Access may be blocked to some websites or to web
browsers operated by certain businesses.

\\ When you are using the Screen Mirroring function,
video stuttering or audio dropouts may occur,
depending on your environment.
\\ Bluetooth transmissions can interfere with the
Screen Mirroring signal. Before using the Screen
Mirroring function, we strongly recommend that you
turn off the Bluetooth function on your smart phone
or smart device (tablet, etc.).
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Link Browsing and Pointer Browsing

1.

2.

•
•
•
1

•
•
•

Press the v button. Link Browsing is
activated and will remain active whenever
you bring up the Web Browser.

•
•

The Control Panel at a Glance

http://www.samsung.com

http://www.samsung.com

100%

New Tab

•
•

Use the ▲▼◀▶ buttons on your remote
to move the pointer to the Link Browser
icon on the top right of the screen. The
Link Browser icon is the third icon from
the right.
The pointer will be in the correct position
if the icon turns blue and the words “Link
Browsing” appear on the screen.

The Control Panel, which runs across the top
of the screen, has a series of icons which start
a number of useful functions. The icons are
described below, starting with the icon on the
far left of the screen.

: Moves to the previous page.
: Moves to the next web page.
: Displays the Bookmarks and History
screen. You can bookmark the current page,
select an existing bookmark, and edit and
delete bookmarks. You can also view your
browsing history and select a page to revisit.
: Moves to the Home screen of the Web
Browser.
: Lets you enter a
page address manually using the keyboard
pop-up.
: Reloads the current page so that it is
refreshed on the screen.
: Adds the current page to your
bookmarks.
: Lets you search for
information by entering words or characters
using the keyboard pop-up. See "Using the
Keyboard Pop-up" on pages 43~44.
: Lets you enlarge or shrink the
screen by various percentages.
/ : Lets you switch between Pointer
Browsing and Link Browsing.
: Lets you configure the Browser’s
settings. See "Using the Settings Menu" on
pages 44~45.
: Closes the Web Browser.
http://www.samsung.com
: Opens a new web
browser tab.

Using the Keyboard Pop-up
When you click the
, the
or access a data or text entry field,
and then press the v button, the keyboard
pop-up appears.
To use the keyboard pop-up with your remote,
follow these steps:
http://www.samsung.com

New Tab

http://www.samsung.com

http://www.samsung.com

100%
100%

New Tab

0 / 100

As you enter characters, recommended text will be shown.
1
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The Web Browser provides two types of
browsing, Pointer Browsing and Link Browsing.
When you launch the browser for the first
time, Pointer Browsing is active. If you are
using a mouse to navigate in the Web Browser,
we recommend leaving Pointer Browsing
active. If you are using your remote to navigate
in the Web Browser, we recommend that you
replace Pointer Browsing with Link Browsing.
Link Browsing moves a highlight from one link
to the next in the Web Browser and is much
faster than Pointer Browsing if you are using
your remote.
To activate Link Browsing, follow these steps:

•
•
•

Network Services
1.

Use the ▲▼◀▶ buttons on your remote
to move the highlight to a letter or
number of your choice.

2.

Press the v button to enter the letter or
number into the entry field.

3.

To access capital letters, move the
highlight to the Caps key on the top left,
and then press the v button. Press
the v button again with the Caps key
highlighted to access small letters again.

4.

To access symbols and additional
punctuation marks, highlight the 123#&
button on the left, and then press the v
button.

5.

To delete a character you entered, move
the highlight to the : button, and then
press the v button.
To delete all the characters you entered,
move the highlight to the Clear button,
and then press the v button.
When finished entering, move the
highlight to the Done button, and then
press the v button.

6.

7.

||NOTE |
\\ If you have a wireless keyboard connected to your
product, you can use the wireless keyboard to enter
letters, numbers, symbols, and punctuation. Note
that the wireless keyboard will work only when the
keyboard popup appears and can only be used to
enter letters, numbers, symbols, and punctuation.

Reset
recommended
text data

Reset erases the Samsung
Keyboard's memory. Select Reset to
erase everything that the Samsung
Keyboard has learned about your
writing style, including any new
words you have used.

Predict Next
Letter

The keyboard predicts the next
letter as you enter letters. The
predictions appear in a ring around
the letter you have just entered.
You can select a predicted letter
or move to another letter. You can
turn this function On or Off.

Accented
character
preview

Select this if you want to type
letters with accent marks.

Using the Setting Menu
The Setting menu contains functions that
control how the Browser operates and Browser
security functions. To open the Setting menu,
highlight the
icon in the Control Panel, and
then press the v button. To select an option
in the setting menu, highlight the option, and
then press the v button.
http://www.samsung.com

http://www.samsung.com

100%

New Tab

Enable Grabbing
Approved Sites
Private Browsing On
Set Search Engine
Web Browser Setting

Options on the Keyboard Pop-Up

Help

To access the keyboard pop-up options,
button on the bottom left of
highlight the
the keyboard, and then press the v button.

Language

Select the language for the
keyboard.
You can select English, French,
Russian, etc.

Recommended
Text

The keyboard suggests
recommended words as you enter
text. You can turn this function On
or Off.
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Close

Enable/Disable
Grabbing

English

Turns the Grabber function on and
off. When the Grabber function is
on, you can move a web page up
and down without dragging the
scroll bar.
The Grabber function is only
available in Pointer Browsing.

Enable or disable the Privacy mode.
When the Privacy mode is enabled,
the browser does not retain the
URLs of sites you visit. If you want
Private Browsing to enable Privacy mode, select OK.
On/Off
If the Privacy mode is running, the
“Stop” icon appears in front of the
URL at the top of the screen. To
disable Privacy mode, select it again
when Privacy mode is enabled.
Set Search
Engine

You can set the desired Search
Engine.
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Set as homepage : You can set the
Browser's home page.
Pop-up Block : Turns the Popup
Block on and off.
Page Block : You can determine
whether to block advertisements
and select the URLs for which
advertisements are blocked.
General : You can delete personal
information such as website history
and browsing data (cookies, etc.),
and reset all web browser settings
to their factory defaults. You can
also set the Security Mode.
Web Browser
Setting

Help

||NOTE |
\\ Set the Security Mode to On
to avoid accessing malicious/
phishing sites and prevent
malicious code from running.
Encoding : You can set the
Encoding setting for web pages to
Automatic or select the encoding
format manually from a list.
Pointer : You can set the speed of
the cursor when the cursor is set to
Pointer and turn Smart Cursor On
and Off.
Browser Information : Displays
the version number and copyright
information for the Web Browser.
Provides basic information about
the operation of the Web Browser.

||NOTE |
\\ Depending on the web site, some of the Web
Browser Setting functions may not be activated.
Functions that are not activated are greyed out and
cannot be used.
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Approved Sites

Lets you restrict your children’s
access to inappropriate web pages
by allowing access only to the web
sites you have registered.
Every time you access this function,
the PIN screen appears. The first
time you access this function, enter
the default PIN, 0000 using the
number buttons on your remote.
You can change the PIN using the
Reset password for the Approved
Sites function. See below.
Approved Sites Feature : Turns the
Approved Sites function on or off.
Reset password for Approved
Sites : Change the Approved Sites
password.
Add current site : Lets you add the
currently displayed web site to the
Approved Sites list.
Manage Approved Sites : Lets you
key in URLs to add to the Approved
Sites List and delete sites from the
Approved Sites list.
If you turn this function on and
have not added any sites to the
Approved Sites list, you will not be
able to access any Internet sites.

Network Services
Linking Your Internet Service
Accounts to the Product
The Link Service Accounts function lets you link
your product to your accounts with Internet
services such as Pandora so that the product
can log you in to the service automatically
when you start the app for that service.
Register your account by going to HOME 
Sign In  Create with Facebook.

BD-LIVE™
Once the product is connected to your
network, you can enjoy various movierelated service contents available on BD-LIVE
compliant discs.
1.

Attach a USB flash memory drive to the
USB jack on the front of the product, and
then check its remaining memory. The
memory device must have at least 1GB of
free space to accommodate the BD-LIVE
services.

2.

Select Settings on the Home screen, and
then press the v button.

3.

Select Network, and then press the v
button.

4.

Select BD-Live Settings, and then press the
v button.

5.

Select BD Data Management, and then
press the v button.

6.

Select Select Device, and then press the
v button.

7.

Select USB device, and then press the v
button.

8.

Insert a Blu-ray Disc that supports BD-LIVE.

9.

Select an item from the list of BD-LIVE
service contents provided by the disc
manufacturer.

||NOTE |
\\ The way you use BD-LIVE and the provided contents
may differ, depending on the disc manufacturer.
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Additional Information

3D Settings
• For some 3D discs, to stop a movie during 3D playback, press the 5 (STOP) button
once. The movie stops and the 3D mode option is de-activated.
To change a 3D option selection when you are playing a 3D movie, press the 5 (STOP)
button once. The Home Screen menu appears. Press the 5 (STOP) button again, then
select 3D Settings in the Blu-ray menu.
• Depending on the content and the position of the picture on your TV screen, you may
see vertical black bars on the left side, right side, or both sides.
TV Aspect Ratio
• Depending on the disc type, some aspect ratios may not be available.
• If you select an aspect ratio and option that is different than the aspect ratio of your TV
screen, the picture might appear to be distorted.
• If you select the 16:9 Original, your TV may display 4:3 Pillarbox (black bars on the sides
of the picture).
BD Wise (Samsung Products only)

Settings

• When BD Wise is on, the Resolution setting automatically defaults to BD Wise and BD
Wise appears in the Resolution menu.
• If the product is connected to a device that does not support BD Wise, you cannot use
the BD Wise function.
• For proper operation of BD Wise, set the BD Wise option of both the product and the TV to On.
Digital Output
• Be sure to select the correct Digital Output or you will hear no sound or just loud noise.
• If the HDMI device (AV receiver, TV) is not compatible with compressed formats (Dolby
Digital, DTS), the audio signal outputs as PCM.
• Regular DVDs do not have BONUSVIEW audio and Navigation Sound Effects.
• Some Blu-ray Discs do not have BONUSVIEW audio and Navigation Sound Effects.
• This Digital Output setup does not affect the HDMI audio output to your TV.
It affects the optical and HDMI audio output when your product is connected to an AV receiver.
• If you play MPEG audio soundtracks, the audio signal outputs as PCM regardless of your
Digital Output selections (PCM or Bitstream).
PCM Downsampling
• Even when PCM Downsampling is set to Off, some discs will only output downsampled
audio through the optical digital output.
• HDMI
-- If your TV is not compatible with compressed multi-channel formats (Dolby Digital,
DTS), the product may output PCM 2ch downmixed audio even though you selected
Bitstream (either Reencoded or Unprocessed) in the setup menu.
-- If your TV is not compatible with PCM sampling rates over 48kHz, the product may
output 48kHz.
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Notes

Appendix
BD-LIVE Internet Connection
• What is a valid certificate?
When the product uses BD-LIVE to send the disc data and a request to the server to
certify the disc, the server uses the transmitted data to check if the disc is valid and
sends the certificate back to the product.
• The Internet connection may be restricted while you are using BD-LIVE contents.
BD Data Management

Settings

• In the external memory mode, disc playback may be stopped if you disconnect the USB
device in the middle of playback.
• Only those USB devices formatted in the FAT file system (DOS 8.3 volume label) are
supported.
We recommend you use USB devices that support USB 2.0 protocol with 4 MB/sec or
faster read/write speed.
• The Resume Play function may not work after you format the storage device.
• The total memory available to BD Data Management may differ, depending on
conditions.
Anynet+ (HDMI-CEC)
• Depending on your TV, certain HDMI output resolutions may not work. Please refer to
the user manual of your TV.
• This function is not available if the HDMI cable does not support CEC.
• If your Samsung TV has an Anynet+ logo, then it supports the Anynet+ function.
Selecting the Audio Language
• The ◀▶ indicator will not appear on the screen if the BONUSVIEW section does not
contain any BONUSVIEW audio settings.
• The languages available through the Audio Language function depend on the
languages that are encoded on the disc. This function or certain languages may not be
available.
• Some Blu-ray Discs may allow you to select either the PCM or Dolby Digital audio
soundtrack in English.

Media Play

Selecting the Subtitle Language
• Depending on the Blu-ray Disc / DVD, you may be able to change the subtitle language
in the Disc Menu. Press the DISC MENU button.
• This function depends on the selection of subtitles that are encoded on the disc and
may not be available on all Blu-ray Discs/DVDs.
• Information about the main feature BONUSVIEW mode will also appear if the Blu-ray
Disc has a BONUSVIEW section.
• This function changes both the primary and secondary subtitles at the same time.
• The total number of primary and secondary subtitles, respectively, is displayed.
• If you press the SUBTITLE button on the remote control, the subtitle bar appears.
Press the RETURN button to remove the subtitle bar.
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Resolution according to the contents type
Blu-ray Disc

E-contents/
Digital contents

BD Wise
Auto

UHD Output :
Movie Frame :
Auto
Auto
UHD Output : Off
Movie Frame : Off
Movie Frame : Auto (24Fs)
※ 1080p & 1080i only
1080p
1080i
720p
480p

Resolution of Blu-ray Disc

1080p@60F

2160p@24F

2160p@24F

1080p@24F
Max. Resolution of TV input

1080p@24F
Max. Resolution of TV input

1080p@24F

1080p@24F

1080p@60F
1080i
720p
480p

1080p@60F
1080i
720p
480p

Contents Type
Setup
BD Wise

Auto

DVD
480i

UHD Output :
Auto
DVD 24Fs Conversion : Auto
Movie Frame :
Auto
UHD Output : Off
DVD 24Fs Conversion : Off
Movie Frame : Off
Movie Frame : Auto (DVD 24Fs Conversion : Auto )
※ 1080p & 1080i only
1080p
1080i
1080i
720p
720p
480p
480p

2160p@24F
1080p@24F
Max. Resolution of TV input
Max. Resolution of TV input
1080p@24F
1080p@60F
1080i
720p
480p

||NOTE |
\\ If the TV you connected to the product does not support Movie Frame or the resolution you selected, the
message "If no pictures are shown after selecting 'Yes', please wait for 15 seconds to return to the previous
resolution. Do you want to change the resolution? " appears. If you select Yes, the TV's screen will go blank for 15
seconds, and then the resolution will revert to the previous resolution automatically.
\\ If the screen stays blank after you have changed the resolution, remove all discs, and then press and hold the
@ button on the top of the product for more than 5 seconds. The initialization message appears on the screen,
the player turns off automatically. When you turn your product on again, all the settings will be reset. Run the
Initial Settings procedure again. Then, go to Settings > Picture > Resolution in the Menu, and select the correct
resolution for your TV.
\\ When you run the Initial Settings procedure, re-select the language and aspect ratio (screen size and format)
only. Resetting does not affect your network settings, so you should be able to skip Network Setup and Software
Update.
\\ When the factory default settings are restored, all stored user BD data is deleted.
\\ A Blu-ray Disc must have the 24 frame feature for the product to use the Movie Frame (24Fs) mode.
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Contents Type
Setup

Appendix
Digital Output Selection
Setup

Bitstream
(Unprocessed)

PCM

Connection

HDMI
supported
AV receiver

Up to PCM
7.1ch
Up to PCM
Dolby Digital
7.1ch
Dolby Digital Up to PCM
Plus
7.1ch
Dolby
Up to PCM
Audio Stream
TrueHD
7.1ch
on Blu-ray
Up to PCM
Disc
DTS
6.1ch
PCM

Optical

HDMI
supported
AV receiver

PCM 2ch

PCM

Dolby
Digital
Dolby
PCM 2ch
Digital Plus
Dolby
PCM 2ch
TrueHD
PCM 2ch

PCM 2ch

DTS

DTSDTS-HD High
HD High
Up to PCM
PCM 2ch
Resolution
Resolution
7.1ch
Audio
Audio
DTS-HD
Up to PCM
Master Audio
7.1ch
PCM
PCM 2ch
Up to PCM
Audio Stream Dolby Digital
5.1ch
on DVD
Up to PCM
DTS
6.1ch

Definition
for Blu-ray
Disc

Any

Optical

Bitstream
(Re-encoded
DTS)

HDMI
HDMI supported
supported AV
AV receiver or
receiver or
Optical
Optical

PCM 2ch DTS re-encoded
Dolby
Digital
Dolby
Digital
Dolby
Digital

Bitstream
(Re-encoded
Dolby D)

DTS re-encoded
DTS re-encoded
DTS re-encoded

DTS

DTS re-encoded

DTS

DTS re-encoded

Re-encoded
Dolby Digital *
Re-encoded
Dolby Digital *
Re-encoded
Dolby Digital *
Re-encoded
Dolby Digital *
Re-encoded
Dolby Digital *
Re-encoded
Dolby Digital *

DTS-HD
Re-encoded
DTS
DTS re-encoded
Master Audio
Dolby Digital *
PCM 2ch PCM 2ch
PCM 2ch
PCM 2ch
PCM 2ch
Dolby
Dolby
PCM 2ch
Dolby Digital
Dolby Digital
Digital
Digital
PCM 2ch

PCM 2ch

DTS

DTS

DTS

Decodes the main
feature audio
Outputs only the main
Decodes the main
and BONUSVIEW
feature audio stream
feature audio and
audio stream
so that your AV receiver
BONUSVIEW audio
together into PCM
can decode the audio
stream together into
audio and adds
bitstream.
PCM audio and adds
Navigation Sound
You will not hear
Navigation Sound
Effects, then reBONUSVIEW audio or
Effects.
encodes the PCM
Navigation Sound Effects.
audio into DTS
bitstream.

DTS
Decodes the main
feature audio and
BONUSVIEW audio
stream together
into PCM audio and
adds Navigation
Sound Effects,
then re-encodes
the PCM audio
into Dolby Digital
bitstream or PCM.

* If the Source Stream is 2ch or mono, "Re-encoded Dolby D" Settings are not applied. Output will
be PCM 2ch.
Blu-ray Discs may include three audio streams :
-- Main Feature Audio : The audio soundtrack of the main feature.
-- BONUSVIEW audio : An additional soundtrack such as the director or actor's commentary.
-- Navigation Sound Effects : When you choose some menu navigation, Navigation Sound Effects
may sound. Navigation Sound Effects are different on each Blu-ray Disc.
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Troubleshooting
Before requesting service, please try the following solutions.
SOLUTION

No operation can be performed with the • Check the batteries in the remote control. They may need replacing.
remote control.
• Operate the remote control at a distance of no more than 20 feet
from the product.
• Remove the batteries and hold down one or more buttons for
several minutes to drain the microprocessor inside the remote
control to reset it. Reinstall the batteries and try to operate the
remote control again.
The disc does not play.

• Ensure that the disc is installed with the label side facing up.
• Check the region number of the Blu-ray Disc/DVD.

The disc Menu does not appear.

• Ensure that the disc has disc menus.

The prohibition message appears on the
screen.

• This message appears when an invalid button is pressed.
• The Blu-ray Disc/DVD's software doesn't support the feature (e.g., angles).
• You've requested a title or chapter number or search time that is out
of range.

Play mode differs from the Setup Menu
selection.

• Some of the functions selected in the Setup Menu may not work
properly if the disc is not encoded with the corresponding function.

The screen ratio cannot be changed.

• The Screen Ratio is fixed on your Blu-ray Disc/DVD.
• This is not a problem with the product.

No audio.

• Make sure you have selected the correct Digital Output in the Audio
Options Menu.

The screen is blank.

• If the HDMI output is set to a resolution your TV cannot support (for
example, 1080p), you may not see a picture on your TV.
• Press the @ button (on top panel) for more than 5 seconds with no
disc inside. The initialization message appears on the screen, and
the player turns off automatically. When you turn your product on
again, all the settings will be reset.
• When the factory default settings are restored, all stored user BD
data will be deleted.

Forgot password.

• Press the @ button (on top panel) for more than 5 seconds with no
disc inside. The initialization message appears on the screen, and
the player turns off automatically. When you turn your product on
again, all the settings will be reset.
Don't use this unless absolutely necessary.
• When the factory default settings are restored, all stored user BD
data will be deleted.
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PROBLEM

Appendix
PROBLEM

SOLUTION

The picture is noisy or distorted.

• Make sure that the disc is not dirty or scratched.
• Clean the disc.

No HDMI output.

• Check the connection between the TV and the HDMI jack of the
product.
• Check if your TV supports the 480p, 720p, 1080i or 1080p HDMI
input resolution.

Abnormal HDMI output appears on the
screen.

• If random noise appears on the screen, it means that TV does not
support HDCP (High-bandwidth Digital Content Protection).

If you experience other problems.

• Go to the table of contents and find the section of the user manual
that contains information about the feature you are having the
problem with, and then follow the procedure again.
• If you still cannot resolve the problem, please contact your nearest
Samsung authorized service center.

Play Multimedia on network devices
You can see folders shared on network
devices, but cannot see the files.

• Multimedia list only shows Video, Photo, and Music files. Other
types of files are not displayed.

Video plays intermittently.

• Check if the network is stable.
• Check if the network cable is properly connected and if the network
is not overloaded.
• The wireless connection between the AllShare compatible device
and the product is unstable.
Check the connection.

The Network connection between the
product and the PC is unstable.

• IP addresses within the same subnetwork should be unique.
If they are not, IP interference can cause this phenomenon.
• Check if you have a firewall enabled.
If so, disable the firewall function.
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PROBLEM

SOLUTION

BD-LIVE
• Test whether the network connection is working using the Network
Status function. (See page 18)
• Check whether a USB memory device is connected to the product.
• The memory device must have at least 1GB of free space to
accommodate the BD-LIVE service.
You can check the available size in BD Data Management. (See page 19)
• See if the BD-LIVE Internet Connection option is set to Allow(All).
• If all above fails, contact the contents provider or update to the
product to the latest firmware.

When using the BD-LIVE service, an error • The memory device must have at least 1GB of free space to
occurs.
accommodate the BD-LIVE service.
You can check the available size in BD Data Management. (See page 19)
||NOTE |
\\ When the factory default settings are restored, all stored user BD data will be deleted.

Repairs
If you contact us to repair your product, an administration fee may be charged if either:
1.

An engineer is called out to your home at your request and there is no defect in the product.

2.

You bring the unit to a repair center and there is no defect in the product.

We will provide you with the amount of the administration fee before we make a home visit or
begin any work on your product.
We recommend you read this manually thoroughly, search for a solution on line at
www.samsung.com, or contact Samsung Customer Care at 1-800-SAMSUNG (726-7864) before
seeking to repair your product.

53

English

07 Appendix

This product cannot connect to the BDLIVE server.

Appendix
Disc and Format Compatibility
Disc types and contents your product can play
Media

VIDEO

MUSIC

PHOTO

Disc Type
Blu-ray Disc
3D Blu-ray Disc
DVD-VIDEO
DVD-RW
DVD-R
DVD+RW
DVD+R
CD-RW/-R,
DVD-RW/-R,
BD-RE/-R
CD-RW/-R,
DVD-RW/-R,
BD-RE/-R

Details
BD-ROM or BD-RE/-R recorded in the BD-RE format.

DVD-VIDEO, recorded DVD+RW/DVD-RW(V)/DVD-R/+R that have been recorded
and finalized, or a USB storage media containing MKV, MP4 contents.

Music recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media
containing MP3 or WMA contents.
Photos recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media
containing JPEG contents.

||NOTE |
\\ The product may not play certain CD-RW/-R and DVD-R because of the disc type or recording conditions.
\\ If a DVD-RW/-R has not been recorded properly in DVD video format, it will not be playable.
\\ Your product will not play content that has been recorded on a DVD-R at a bit-rate that exceeds 10 Mbps.
\\ Your product will not play content that has been recorded on a BD-R or USB device at a bitrate that exceeds 25
Mbps.
\\ Playback may not work for some types of discs, or when you use specific functions, such as angle change and
aspect ratio adjustment. Information about the discs is written in detail on the disc box. Please refer to this if
necessary.
\\ When you play a BD-J title, loading may take longer than a normal title or some functions may perform slowly.

Disc types your product cannot play
• HD DVD
• DVD-ROM/PD/
MV, etc

• DVD-RAM
• Super Audio CD
(except CD layer)
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• DVD-RW (VR mode) • 3.9 GB DVD-R for
Authoring.
• CVD/CD-ROM/CDV/
CD-G/CD-I/LD
(CD-Gs play audio
only, not graphics.)

English

Region Code

Logos of Discs the product can play

Disc Type

Blu-ray Disc

Region
Code

Area

a

North America, Central
America, South America,
Korea, Japan, Taiwan, Hong
Kong and South East Asia.

b

Europe, Greenland, French
territories, Middle East,
Africa, Australia and New
Zealand.

C

India, China, Russia, Central
and South Asia.

1

The U.S., U.S. territories and
Canada

2

Europe, Japan, the Middle
East, Egypt, Africa,
Greenland

3

Taiwan, Korea, the
Philippines, Indonesia, Hong
Kong

4

Mexico, South America,
Central America, Australia,
New Zealand, Pacific Islands,
Caribbean

5

Russia, Eastern Europe, India,
North Korea, Mongolia

6

China

DVD-VIDEO
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Blu-ray Disc

3D Blu-ray Disc

BD-LIVE

NTSC broadcast system
in U.S.A, Canada, Korea,
Japan
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Both products and discs are coded by region.
These regional codes must match for a disc to
play. If the codes do not match, the disc will
not play.
The Region Number for this product is
displayed on the rear panel of the product.

Appendix
Supported Formats
Video File Support
File Extension

Container

Video Codec

Resolution

MVC
*.avi
*.mkv
*.asf
*.wmv
*.mp4
*.mov
*.3gp
*.vro
*.mpg
*.mpeg
*.ts
*.tp
*.trp
*.mov
*.flv
*.vob
*.svi
*.m2ts
*.mts
*.ps

*.webm

Frame rate
(fps)
24/25/30

Bit rate (Mbps) Audio Codec
60

Motion JPEG
H.264 BP/MP/
HP
AVI
MKV
ASF
MP4
3GP
MOV
FLV
VRO
VOB
PS
TS
SVAF

WebM

MPEG4 SP/ASP
Window Media
Video v9(VC1)

1920x1080

AVS
MPEG2
MPEG1

FHD: MAX 30
HD : MAX 60

30

Microsoft
MPEG-4 v1 , v2
, v3
H 263
Sorrenson
Window
Media Video
v7(WMV1),
v8(WMV2)

1280x720

VP6

640x480

6~30

4

VP8

1920x1080

6~30

20

`` Limitations

AC3
LPCM
ADPCM(IMA,
MS)
AAC
HE-AAC
WMA
Dolby Digital
Plus
MPEG(MP3)
DTS

Vorbis

-- Even when a file is encoded by a supported codec listed in the Video File Support table, the file
might not play if its content has a problem.
-- Normal playback is not guaranteed if the file’s container information is wrong or the file itself is
corrupted.
-- Files having a higher Bit rate/frame rate than indicated in the Video File Support table may stutter
when played back.
-- Seek (Jump) function is not available if the file’s index table is damaged.
-- When you playback a file remotely through a network connection, video playback may stutter
depending on the network speed.
-- Some USB/Digital camera devices may not be compatible with the product.
-- The AVS codec is supported only by models made for China.
-- The *.ps file extension is supported only by models made for China.
-- If the original content of a file was recorded in UHD, it cannot be played.
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`` Video decoder

Internal

`` Audio decoder

-- Supports WMA 10 PRO (Up to 5.1).
-- Does not support WMA lossless audio.
-- Also supports the M2 profile.
-- The RealAudio 10 lossless format is not
supported by models made for China and
Hong Kong.
-- Does not support QCELP/AMR NB/WB.
-- Supports vorbis (Up to 2ch).
-- Supports DD+ (Up to 5.1ch)
-- The DTS LBR codec is supported only for
MKV / MP4 / TS containers.
||NOTE |

\\ Some MKV and MP4 format discs may not play,
depending on their video resolution and frame rate.

Supported Subtitle File Formats

External

Name

File
Extension

MPEG-4 Timed text

.ttxt

SAMI

.smi

SubRip

.srt

SubViewer

.sub

Micro DVD

.sub or.txt

SubStation Alpha

.ssa

Advanced
SubStation Alpha

.ass

Powerdivx

.psb

SMPTE-TT Text

.xml

Xsub

AVI

SubStation Alpha

MKV

Advanced
SubStation Alpha

MKV

SubRip

MKV

VobSub

MKV

MPEG-4 Timed text

MP4

TTML in smooth
streaming

MP4

SMPTE-TT TEXT

MP4

SMPTE-TT PNG

MP4

Music File Support
File
Extension

Type

Codec

Support Range

*.mp3

MPEG

MPEG1
Audio
Layer 3

-

*.m4a
*.mpa
*.aac

MPEG4

AAC

-

*.flac

FLAC

FLAC

Supports up to two
channels.

*.ogg

OGG

Vorbis

Supports up to two
channels.

*.wma

WMA

For WMA. Supports
up to 10 Pro 5.1
channels.
WMA
WMA lossless audio
is not supported.

*.wav

wav

*.mid
*.midi
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File
Extension

Name

English

midi

wav

-

midi

Type 0, type 1
and Seek is not
supported.
Only available with
USB.
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-- Supports up to H.264 Level 4.1. (Does not
support FMO/ASO/RS)
-- Does not support VC1/AP/L4.
-- CODECs except for WMVv7, v8, MSMPEG4
v3, MVC, VP6
1) Below 1280 x 720 : 60 frames max.
2) Above 1280 x 720 : 30 frames max.
-- Does not support GMC 2 or higher.
-- Supports SVAF Top/Bottom, Side by Side ,
Left/Right view sequence type(2 ES)
-- Supports BD MVC Spec.

Appendix
File
Extension

Type

Codec

Support Range

*.ape

ape

ape

NVT and X13 is not
supported.

*.aif
*.aiff

AIFF

AIFF

-

*.m4a

ALAC

ALAC

-

Picture File Support
File Extension

Type

Resolution

*.jpg
*.jpeg

JPEG

15360x8640

*.png

PNG

4096x4096

*.bmp

BMP

4096x4096

*.mpo

MPO

15360x8640

• Your player only supports USB Mass Storage
Class (MSC) devices such as thumb drives
and USB HDD. (HUB is not supported.)
• Certain USB HDD Devices, multi-card readers
and thumb drives may not be compatible
with this player.
• If some USB devices require excessive power,
they may be limited by the circuit safety
device.
• If playback from a USB HDD is unstable,
provide additional power by plugging the
HDD into a wall socket.
If the problem continues, contact the USB
HDD manufacturer.
• SAMSUNG is not responsible for any data
file damage or data loss.
• Your player does not support NTFS
compressed, sparse, or encrypted files.
-- You can repair or format a USB device on
your Desktop PC. (MS-Windows OS only)

AVCHD (Advanced Video Codec High
Definition)

Notes on the USB connection
• Your player supports USB storage media,
MP3 players, digital cameras, and USB card
readers.
• Some USB/digital camera devices may not be
compatible with the player.
• Your player supports the FAT16, FAT32, and
NTFS files systems.
• Connect USB devices directly to the player's
USB port. Connecting through a USB cable
may cause compatibility problems.
• Inserting more than one memory device into
a multi-card reader may cause the reader to
operate improperly.
• The player does not support the PTP (Peer to
Peer) protocol.
• Do not disconnect a USB device while it is
transferring or recording data.
• The bigger the image resolution, the longer
the image takes to display.
• This player cannot play MP3 files with DRM
(Digital Rights Management) downloaded
from commercial sites.
• Your player only supports video that is under
30fps (frame rate).

58

• This player can play back AVCHD format
discs. These discs are normally recorded and
used in camcorders.
• The AVCHD format is a high definition digital
video camera format.
• The MPEG-4 AVC/H.264 format compresses
images with greater efficiency than the
conventional image compressing format.
• Some AVCHD discs use the "x.v.Color"
format. This player can play back AVCHD
discs that use "x.v.Color" format.
• "x.v.Color" is a trademark of Sony
Corporation.
• "AVCHD" and the AVCHD logo are
trademarks of Matsushita Electronic
Industrial Co., Ltd. and Sony Corporation.
||NOTE |
\\ Some AVCHD format discs may not play, depending
on the recording conditions.
AVCHD format discs need to be finalized.
\\ "x.v.Color" offers a wider color range than normal
DVD camcorder discs.

English

Compliance and Compatibility Notice
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NOT ALL discs are compatible
• Subject to the restrictions described below and those noted throughout this Manual, including
the Disc Type and Characteristics section of this user manual, disc types that can be played
are: pre-recorded commercial BD-ROM, DVD-VIDEO, and Audio CD (CD-DA); BD-RE/-R, DVDRW/-R; and CD-RW/-R.
• Discs other than the above cannot and/or are not intended to be played by this player. And
some of the above discs may not play due to one or more reasons provided below.
• Samsung cannot assure that this player will play every disc bearing the BD-ROM, BD-RE/-R,
DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and CD-RW/-R logos, and this player may not
respond to all operating commands or operate all features of every disc. These and other
disc compatibility and player operation issues with new and existing format discs are possible
because:
-- Blu-ray is a new and evolving format and this player may not operate all features of Blu-ray
Discs because some features may be optional, additional features may have been added to
the Blu-ray Disc format after the production of this player, and certain available features may
be subject to delayed availability;
-- not all new and existing disc format versions are supported by this player;
-- new and existing disc formats may be revised, changed, updated, improved and/or
supplemented;
-- some discs are produced in a manner that allows specific or limited operation and feature
during playback;
-- some features may be optional, additional features may have been added after the production
of this player or certain available features may be subject to delayed availability;
-- some discs bearing the BD-ROM, BD-RE/-R, DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and
CD-RW/-R logos may still be non-standardized discs;
-- some discs may not be played depending on their physical state or recording conditions;
-- problems and errors can occur during the creation of Blu-ray Disc, DVD software and/or the
manufacture of discs;
-- this player operates differently than a standard DVD player or other AV equipment; and/or
-- for reasons noted throughout this user manual and for other reason(s) discovered and posted
by SAMSUNG customer care center.
• If you encounter disc compatibility or player operation problems, please contact SAMSUNG
customer care center.
You may also contact SAMSUNG customer care center for possible updates on this player.
• For additional information on playback restrictions and disc compatibility, refer to the
Precautions, Before Reading the user manual, Disc Types and Characteristics, and Before Playing
sections of this user manual.
• For product progressive scan output : CONSUMERS SHOULD NOTE THAT NOT ALL HIGH
DEFINITION TELEVISION SETS ARE FULLY COMPATIBLE WITH THIS PRODUCT AND MAY
CAUSE ARTIFACTS TO BE DISPLAYED IN THE PICTURE. IN CASE OF PROGRESSIVE SCAN
PICTURE PROBLEMS, IT IS RECOMMENDED THAT THE USER SWITCH THE CONNECTION TO
THE 'STANDARD DEFINITION' OUTPUT. IF THERE ARE QUESTIONS REGARDING OUR TV SET
COMPATIBILITY WITH THIS PRODUCT, PLEASE CONTACT OUR CUSTOMER SERVICE CENTER.

Appendix
Copy Protection
• Because AACS (Advanced Access Content System) is approved as content protection system for
Blu-ray Disc format, similar to use of CSS (Content Scramble System) for DVD format, certain
restrictions are imposed on playback, analog signal output, etc., of AACS protected contents.
The operation of this product and restrictions on this product may vary depending on your time
of purchase as those restrictions may be adopted and/or changed by AACS after the production
of this product. Furthermore, BD-ROM Mark and BD+ are additionally used as content
protection system for Blu-ray Disc format, which imposes certain restrictions including playback
restrictions for BD-ROM Mark and/or BD+ protected contents. To obtain additional information
on AACS, BD-ROM Mark, BD+, or this product, please contact SAMSUNG customer care center.
• Many Blu-ray Disc/DVDs are encoded with copy protection. Because of this, you should only
connect your Player directly to your TV, not to a VCR. Connecting to a VCR results in a distorted
picture from copy-protected Blu-ray Disc/DVDs.
• Under the U.S. Copyright laws and Copyright laws of other countries, unauthorized recording,
use, display, distribution, or revision of television programs, videotapes, Blu-ray Discs, DVDs,
and other materials may subject you to civil and/or criminal liability.
• Cinavia Notice : This product uses Cinavia technology to limit the use of unauthorized copies of
some commercially-produced film and videos and their soundtracks. When a prohibited use of
an unauthorized copy is detected, a message will be displayed and playback or copying will be
interrupted.
More information about Cinavia technology is provided at the Cinavia Online Consumer
Information Center at http://www.cinavia.com. To request additional information about Cinavia
by mail, send a postcard with your mailing address to: Cinavia Consumer Information Center, P.O.
Box 86851, San Diego, CA, 92138, USA.
This product incorporates proprietary technology under license from Verance Corporation and is
protected by U.S. Patent 7,369,677 and other U.S. and worldwide patents issued and pending
as well as copyright and trade secret protection for certain aspects of such technology. Cinavia
is a trademark of Verance Corporation. Copyright 2004-2010 Verance Corporation. All rights
reserved by Verance. Reverse engineering or disassembly is prohibited.

Network Service Disclaimer
All content and services accessible through this device belong to third parties and are protected
by copyright, patent, trademark and/or other intellectual property laws. Such content and
services are provided solely for your personal noncommercial use. You may not use any content
or services in a manner that has not been authorized by the content owner or service provider.
Without limiting the foregoing, unless expressly authorized by the applicable content owner or
service provider, you may not modify, copy, republish, upload, post, transmit, translate, sell, create
derivative works, exploit, or distribute in any manner or medium any content or services displayed
through this device.
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Licenses
• Manufactured under license from Dolby Laboratories. Dolby and the double-D
symbol are registered trademarks of Dolby Laboratories.
• For DTS patents, see http://patents.dts.com. Manufactured under license
from DTS Licensing Limited. DTS, DTS-HD, the Symbol, & DTS and the Symbol
together are registered trademarks, and DTS-HD Master Audio is a trademark of DTS, Inc. ©
DTS, Inc. All Rights Reserved.
• The terms HDMI and HDMI High-Definition Multimedia Interface, and the
HDMI Logo are trademarks or registered trademarks of HDMI Licensing LLC in
the United States and other countries.
• Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names
may be trademarks of their respective owners.

• Open Source License Notice
-- In the case of using open source software, Open Source Licenses are available on the product
menu.
• Blu-ray Disc™, Blu-ray™ and the logos are trademarks of the Blu-ray Disc Association.
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THIRD PARTY CONTENT AND SERVICES ARE PROVIDED "AS IS." SAMSUNG DOES NOT WARRANT
CONTENT OR SERVICES SO PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY, FOR ANY PURPOSE.
SAMSUNG EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED
TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SAMSUNG
DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS, LEGALITY, OR COMPLETENESS
OF ANY CONTENT OR SERVICE MADE AVAILABLE THROUGH THIS DEVICE AND UNDER NO
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE LIABLE, WHETHER IN
CONTRACT OR TORT, FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL
DAMAGES, ATTORNEY FEES, EXPENSES, OR ANY OTHER DAMAGES ARISING OUT OF, OR IN
CONNECTION WITH, ANY INFORMATION CONTAINED IN, OR AS A RESULT OF THE USE OF ANY
CONTENT OR SERVICE BY YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.
Third party services may be terminated or interrupted at any time, and Samsung makes no
representation or warranty that any content or service will remain available for any period of time.
Content and services are transmitted by third parties by means of networks and transmission
facilities over which Samsung has no control. Without limiting the generality of this disclaimer,
Samsung expressly disclaims any responsibility or liability for any interruption or suspension of any
content or service made available through this device.
Samsung is neither responsible nor liable for customer service related to the content and services.
Any question or request for service relating to the content or services should be made directly to
the respective content and service providers.

Appendix
Specifications

General

USB
HDMI
Audio Output

Network

Power Requirements
Power Consumption
Weight
Dimensions
Operating Temperature Range
Operating Humidity Range
Type A
DC output
Video
Audio
Digital Audio Output
Ethernet
Wireless LAN
Security
WPS(PBC)

•
•
•
•

AC110-120V 50/60Hz
18.5W
2.6 Ibs
14.2 (W) X 7.7 (D) X 1.6 (H) inches
+41°F to +95°F
10 % to 75 %
USB 2.0
5V 500mA Max.
2D : 2160p, 1080p, 1080i, 720p, 480p
3D : 1080p, 720p
PCM, Bitstream
Optical
100BASE - TX Terminal
Built-in
WEP (OPEN/SHARED)
WPA-PSK (TKIP/AES)
WPA2-PSK (TKIP/AES)
Supported

Network speeds equal to or below 10Mbps are not supported.
Design and specifications are subject to change without prior notice.
Weight and dimensions are approximate.
Dispose unwanted electronics through an approved recycler.
To find the nearest recycling location, go to our website: www.samsung.com/recyclingdirect or
call, (877) 278 - 0799.
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LIMITED WARRANTY TO ORIGINAL PURCHASER
This SAMSUNG brand product, as supplied and distributed by SAMSUNG and delivered new, in the original carton to the
original consumer purchaser, is warranted by SAMSUNG against manufacturing defects in materials and workmanship for a
limited warranty period of:
One (1) Year Parts and Labor*
(*90 Days Parts and Labor for Commercial Use)
This limited warranty begins on the original date of purchase, and is valid only on products purchased and used in the
United States. To receive warranty service, the purchaser must contact SAMSUNG for problem determination and service
procedures. Warranty service can only be performed by a SAMSUNG authorized service center. The original dated bill
of sale must be presented upon request as proof of purchase to SAMSUNG or SAMSUNG's authorized service center.
Transportation of the product to and from the service center is the responsibility of the purchaser.
SAMSUNG will repair or replace this product, at our option and at no charge as stipulated herein, with new or
reconditioned parts or products if found to be defective during the limited warranty period specified above. All replaced
parts and products become the property of SAMSUNG and must be returned to SAMSUNG. Replacement parts and
products assume the remaining original warranty, or ninety (90) days, whichever is longer.
SAMSUNG’s obligations with respect to software products distributed by SAMSUNG under the SAMSUNG brand name are
set forth in the applicable end user license agreement. Non-SAMSUNG hardware and software products, if provided, are on
an “AS IS” basis.
Non-SAMSUNG manufacturers, suppliers, publishers, and service providers may provide their own warranties.
This limited warranty covers manufacturing defects in materials and workmanship encountered in normal, and except to
the extent otherwise expressly provided for in this statement, noncommercial use of this product, and shall not apply to the
following, including, but not limited to: damage which occurs in shipment; delivery and installation; applications and uses
for which this product was not intended; altered product or serial numbers; cosmetic damage or exterior finish; accidents,
abuse, neglect, fire, water, lightning or other acts of nature; use of products, equipment, systems, utilities, services, parts,
supplies, accessories, applications, installations, repairs, external wiring or connectors not supplied and authorized by
SAMSUNG, or which damage this product or result in service problems; incorrect electrical line voltage, fluctuations and
surges; customer adjustments and failure to follow operating instructions, cleaning, maintenance and environmental
instructions that are covered and prescribed in the instruction book; product removal or reinstallation; reception problems
and distortion related to noise, echo, interference or other signal transmission and delivery problems. SAMSUNG does not
warrant uninterrupted or error-free operation of the product.
THERE ARE NO EXPRESS WARRANTIES OTHER THAN THOSE LISTED AND DESCRIBED ABOVE, AND NO WARRANTIES
WHETHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE, SHALL APPLY AFTER THE EXPRESS WARRANTY PERIODS STATED ABOVE, AND
NO OTHER EXPRESS WARRANTY OR GUARANTY GIVEN BY ANY PERSON, FIRM OR CORPORATION WITH RESPECT TO
THIS PRODUCT SHALL BE BINDING ON SAMSUNG. SAMSUNG SHALL NOT BE LIABLE FOR LOSS OF REVENUE OR PROFITS,
FAILURE TO REALIZE SAVINGS OR OTHER BENEFITS, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES
CAUSED BY THE USE, MISUSE OR INABILITY TO USE THIS PRODUCT, REGARDLESS OF THE LEGAL THEORY ON WHICH
THE CLAIM IS BASED, AND EVEN IF SAMSUNG HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL
RECOVERY OF ANY KIND AGAINST SAMSUNG BE GREATER IN AMOUNT THAN THE PURCHASE PRICE OF THE PRODUCT
SOLD BY SAMSUNG AND CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, PURCHASER
ASSUMES ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO PURCHASER AND PURCHASER’S PROPERTY AND
TO OTHERS AND THEIR PROPERTY ARISING OUT OF THE USE, MISUSE OR INABILITY TO USE THIS PRODUCT SOLD BY
SAMSUNG NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF SAMSUNG. THIS LIMITED WARRANTY SHALL NOT EXTEND
TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THIS PRODUCT, IS NONTRANSFERABLE AND STATES YOUR
EXCLUSIVE REMEDY.
Some states do not allow limitations on how long an implied warranty lasts, or the exclusion or limitation of incidental or
consequential damages, so the above limitations or exclusions may not apply to you. This warranty gives you specific legal
rights, and you may also have other rights which vary from state to state.
To obtain warranty service, please contact SAMSUNG customer care center.
The benefits of this Limited Warranty extend only to the original purchaser of Samsung products from an authorized
Samsung reseller.
THIS LIMITED WARRANTY SHALL NOT APPLY TO ANY SAMSUNG PRODUCTS PURCHASED FROM UNAUTHORIZED
RESELLERS OR RETAILERS, EXCEPT IN STATES WHERE SUCH RESTRICTION MAY BE PROHIBITED.
For a list of Samsung authorized retailers, please go to: http://www.samsung.com/us/peaceofmind/
authorized_resellers.html.

QUESTIONS OR COMMENTS?
COUNTRY

CALL

OR VISIT US ONLINE AT

WRITE

IN THE US

1-800-SAMSUNG
(726-7864)

www.samsung.com/us

Samsung Electronics America, Inc.
85 Challenger Road Ridgefield Park,
NJ 07660

© 2014 Samsung Electronics Co., Ltd. All rights reserved.
AK68-02465A-00
AK68-02465A

